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SKYDOME TECHNICAL CHARACTERISTICS

Concrete col tion of the slab
mm®

Slab Slab
thickness thickness thickness
100 mm 150 mm
120 | 154 | 19 140 | 700 820 0080 | 0.130 0180 | 0.230
Skydome H200 160 193 | 237 140 | 700 B60 0.091 0.141 0191 | 02#
200 233 | 279 | 140 | 700 900 0100 | 0.150 0200 | 0250
120 | 17a | 213 | 10 | 700 | 820 0039 | 0.149 0193 | 0249
Skydome H250 160 | 210 | 254 | 140 | 700 BEO 0.113 0.163 0213 | 0263
200 | 250 | 285 | 40 | 700 200 0125 | 0175 0225 | 0275
120 205 | 267 | 140 | oo 820 0123 | 0173 0223 | 02713
Skydome H300 160 245 308 140 | 700 B60 0139 | 0.189 0738 | 0289
200 285 350 140 | 700 200 0153 | 0203 0253 | 0303
120 | 263 302 140 | 700 820 | 0151 0.201 0231 | 030
Skydome H350 160 | 303 347 140 | Y00 860 0189 | 0219 0268 | 0319
200 | 343 | 3@4 140 | 700 200 0.185 0.235 0285 | 0335
120 | 38 | 3m7 140 | 700 B0 | 0485 0.235 p285 | 0335
Skydome H400 160 | 388 | 388 40 | 700 B60 | 0205 | 0.255 0.305 0.355
200 | 428 | 430 140 | 700 800 0222 0.272 0322 0.372
Max, slab | Beam widlh Slab Salf Liva Wire mesh
L1 {rrim) Thickness welgnt 1oad characteristics
H1 (i} kg/m® kel
[ 5.0 120 50 325 400 2.28 20012 | 201 |DNazooxzoo |
&.00 160 50 353 400 2268 2dn12 2.0 DN&/200X200
&.00 160 =0 408 400 3.08 2dn14 2.01 DME/200X200
&.50 180 50 408 400 3.08 2dn14 2.01 DMNB/200:200

(SKYDOME ProductSheet) Jélg slo &gl (BuicSudsi Jolis diges & JSis

Sl oas ools HLas VS 10 aS 5 1o 092 g Seb ol (gl (gl e o lasliwl sl 5 sasie VLI jo pl 1 0gdle

12
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8,10, 12, 14, 16 for 19-in. domes

8, 10, 12, 14, 18, 20 for 24-in. domes

8, 10, 12, 14, 18, 20 for 30-in. domes

2% 1) 19 ST er” 18-in. domes
24

3 24 S8 24-in. domes
30

3'1 20 T3 30-in. domes
36
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Table 22.6.5.2—v. for two-way members without
shear reinforcement

ve
0.33A A1, (a)
0.33
017+ ——— A Jr
Least of (a), (b), and (c): [ = B } M. ®)

0.0830.d .
[0.i?+—-5.—]3.‘7k.\ff ©

Notes:
(1) A, 15 the size effect factor given in 22.5.5.1.3.

(u) B 1s the ratio of long to short sides of the column, concentrated load, or reaction
area

(m) o, 15 given m 226 53

5l ad 6l g Yo (51 sl gt sl Fo) ols (Sotes IS 6l ad 4 s gt il e 0 B lie
0 A5l Jloafjt;aLoLép.ag‘slsb LsLm)ﬂ:A ld )\mpp.mow)f&im‘g}m@lﬁ)‘ sl M; sl gw Ve
(wight, 2016) sgs

{b} Critical perimeters if A and B8 do not excead Lhe graater of 47 or 24y,

Edge of slab 7

(c) Critical perimeters if A exceads the greater of 4 or 26y, but 8 does not.
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_ (# of ribs within the drop panel width)x /1 x b,
the drop panel width

d

— ] |~a— by

2y il 5l gy 4l o d lade (3,0 Y SIS
1] (oo Cewy o abal) 5l e Cunl Jolae (LB 52 by oS
b,=b+d/12
Al (g0 4z 2)e D g az s sloo Sl s 3550 b (6,Lad )6 0 5590 alols 0 (3gd alal, 5o
s g5l ] jloslicwl baci Golko of 4ifio iy lawlro Lig,
D9 oo dumle Uy , Ve polie ) SVolee 5l oolitnl b eygiw 51 A/2 alols 4 Jloo ahaio 0 -
W | YorMuxy | YoyMuyx

vy =—+
tA Jx Jy

Table 22.6.5.2—v. for two-way members without
shear reinforcement

»
Ve

033 M7 @
033
0.17+—|A 1.," '
Least of (a), (b), and (c): [ & B ) ML ®

[o, 17+ ﬂ'mf“fd ];Uw’f ©

Notes:
(1) A, 15 the size effect factor given in 22.5.5.1.3.

{u) B 1s the ratio of long to short sides of the column, concentrated load, or reaction
area

(1) o 15 grvenn 226 5 3.
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6,

6in (150 mm)
Iss

o
as required for shear

IfP, 2 0.35A9f =

» Volumetric ratio of hoop
reinforcement along full
helght not less than one-half

Tension lap T that required along I, region of a
special moment frame column

« Maximum cover =4 in (100 mim)
unless additional transverse
reinforcement is provided
with cover <4in (100 mm)
ats=12in {300 mm)

] ]

splice, no
restriction
on location -4
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min h,/4, h,/4

1 : 515 Snb
1[ L as required for shear
h, Fry 6d,

[ h, ] i 5,59 6in {150 mm)
0=71./6 o 3, as required for shear
18 in (460 mm) 4 14=h

L - so=4+( 3 )il"l
= : [100- (350_h') |
Tension lap e 3
splice restricted gt 24in (100 mm)

to center half of

' <6in {150 mm)

member length —— Along I, transverse reinforcement
spacing <5, and quantity

satisfies full confinement
requirements as identified in
Table 12.2

Provide full height if
supparting discontinued stiff
— member,

|, Maximum cover=4in (100 mmj)
[ + unless additional transverse

] reinforcement is provided

with cover <4in (100 mm)
ats=12in (300 mm)
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Table 7.3.1.1—Minimum thickness of solid
nonprestressed one-way slabs

Support condition Minimum Al!l
Simply supported £/20
One end continuous £/24
Both ends continuous €128
Cantilever £/10

[NExpression applicable for normalweight concrete and f, = 420 MPa. For other
cases, minimum / shall be modified in accordance with 7.3.1.1.1 through 7.3.1.1.3,
as appropriate.

)0 J.:Lv Js» )JJLQ.A 05!53 rb-'-L-H-' 6[& wu.a )-)LA-AJ 6‘,» Sl 00 w...la..u fy=420 MPa L.S‘)" sl U""—‘ A Jsd?
Sheed L ogd gy e J L plejed a5 G900 j0 (55l Cuoles 0958l (Sl 09 o yo 0.4+ 700/fy

s ol ,8 ol i aBlae BlasT 4y )8 50 4S5l 0emg ail anils T L S e 5L,
Ao g, V=V=Y-A o j0 - o b ol css s Hlas 0,90 Jlo aSol as a4 ybogd gledld 050 10 asl ]

09 i ad ybgd gldlo 5,50 y0 el 00,5 il e - Jlo gl Y-V-Y-A a5 cou sl sl p culs JBlos
39 [l S g Al polie 9 V-V-Y-A Jgoo polie jlasls s (5 culs do o 4SS o J I sle s

o e VYO  Drop panel 50 slls .l

o Jue Voo Drop Panel l)ls sldls .o

Table 8.3.1.1—Minimum thickness of nonprestressed two-way slabs without interior beams (mm)!!

Without drop panels'®! With drop panels!
Exterior panels Exterior panels
fi» MPall | Without edge beams | With edge beams!] Interior panels Without edge beams | With edge beams™! Interior panels
280 £33 £,136 £,/36 £,36 £,/40 £,/40
420 /30 £33 £33 £,/33 £,/36 /36
550 €27 £,/30 £a30 £,/30 £a/33 £33

[y, is the clear span in the long direction, measured face-to-face of supports (mm).

FlFor f between the values given in the table, minmmm thickness shall be calculated by linear interpolation.

BiDrop panels as given in 8 2 4.

HIS1abs with beams between columns along exterior edges. Exterior panels shall be considered to be without edge beams if ¢yis less than 0.8.

o5 a5l aS o0y 25,5 sl jo dilas s o5lal [, &5 cals a5 b V-V-V-A Jgus 5l eolail plSo
Slre |y 658 Sl witn (sl ad (slays hilo &5 (S sla Bl 6l VN TA Jgaz 09h (o0 (65 o5l
Sl (it )0 U aculxe ogm 28,5 Jlai s asb @ = 0.8 5,50 )0 ol o) I ad (65 paie .l atuils
el o ey L3

A5 el 00 5l YEVFoA 0y 4 o el JBlas dmalns sililone s, cdigrgd 6b (gl pud — J15 350 o
il 25 018 & B e sl

by 51 Sy O Alone -

Conl aalllae 3590 b JIs 6l 4 sl 5 @f Lawgie 4 Ay drlons -
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D90 (o0 dmle s JBlax jlade Y-1-Y-A oo 5l O jlade 0 ais -

Table 8.3.1.2—Minimum thickness of
nonprestressed two-way slabs with beams
spanning between supports on all sides

g, M Minimum /i, mm
g = 0.2 8.3.1.1 applies (a)
£ [0.8+-—---f;' ] s
02 <a. <20 Greater 1400 1
ol of: 36+ 5P(ee, —0.2)
125 (c)
£, 0.8+ f—J]
G Greater 1400 (d)
AR of: 36+9B
90 (e)

Mey, 15 the average value of oy for all beams on edges of a panel.
P, is the clear span in the long direction, measured face-to-face of beams (mm).
IR is the ratio of clear spans in long to short directions of slab.
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Table 24,2, 2—Maximum permissible calculated deflections

Deflection
Member Condition Defiection to be considered limitation
Flat roofs | Mot supporting or attached to nonstroctureal elements likely to Immediate deflection due to maximum of L, 5, and R £/180E0
be damaged by larpe deflections
Floors Immediate deflection due to £ €360

Likely to be dam.agcd by That part of the total deflection occurring afier attachment FraR0]
Roof or Supporting or attached to large defleetions of nonstructural elements, which is the sum of the time-

floors ponstructural clements Mot likely to be damaged dependent deflection due to all sustained loads and the
by latge deflections immediate deflection due to any additional live load™

£12400

ML imit not intended to safeguard against ponding, Ponding shall be checked by caleulutions of deflection, including added deflections due to pondsd water, and considering time-
dependent effects of sustained Inads, camber, construction folerances, and reliability of provisions for drainage.

EMTime-dependent deflection shall be calculated in secordance with 34.2.4, but shall be permitted to be reduced by amount of deflection caleulsted to ocour before attachment of
nonstruztural elements, This amount shall be calculsted on basis of sccepted engineering data relating to time-deflection characteristics of members similar to those being considered,
L imit ghall be permitted to be exeeeded if measures sre taken to prevent damage to supported or attached slements,

FILimit shall not exceed toleranee provided for nonstractrs] elements.
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Table 24.2.4.1.3—Time-dependent factor for
sustained loads

Sustained load duration, months Time-dependent factor §
3 1.0
] 12
12 1.4
60 or more 20

[Branson, 1976] el suis al)l 55 Sle; slash ple Gl loges & g0 4 yial)b o
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0
0 0.25 05 1 5 10 1 2 3 45 100
Months : Years

Duration of load
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Table 2.1—Fire resistance of single-layer concrete
walls, floors, and roofs

hn Minimuom equivalent thickness for fre-resistance rating, in
garemale
Lype | howr  [1-1/2 howrs| 2 hours 3 hours 4 hours
Siliceaus x5 43 50 6.2 70
Carbonate 33 4.0 4.6 37 6.6
Semi- A
lightweight 23 33 38 4.6 54
Lightweight 25 3l 36 44 51
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Table 2.3—Minimum cover in concrete floors and

roof slabs
Cover | for carresponding fire resistance, in.
Aggresate Restrained Unrestrained
ype 4orless | 1 howr |1-172 hours| 2 hours | 3 hours | 4 hours
Nonprestressed
Siliceous 34 a4 4 l I-1/4 | 1-5/8
Carbonate 34 4 34 34 1-14 | 1-1/4
Sermi-
lightweight 34 a4 34 K2 I-1f4 | 1-1i4
Lightweight| 34 4 4 34 I-1/4 | 1-1/4
Prestressed
Siliceous 34 1-1/8 1-142 1-34 | 238 | 234
Carbonate 34 1 1-3/8 1-5/8 | 2-1/8 | 2-1M4
Semi-
lightweight 34 1 1-3/8 1-1/2 2 2-1/4
Lightweight| 3/ 1 1-3/8 1-1/2 2 2-14

s 59y 5l Gigy 09d (o0 DLl (g liee 5551 P S 9550 lies 5 i sl AlaSis g9 a Aty G byl o
ool 55 o 13 5l el Sae Ll 40 0550 4 dis 4S5l Az g5 b 0gd o 605 05lal Job sleo Ko (59, b 0 ol
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Table 2.4—Minimum cover in nonprestressed beams

Beam | Cover for comesponding fire-resistance rating, in.
width,
Restraint in. I howr | 1-1/2 howrs | 2 howrs | 3 howrs | 4 hours
5 34 374 M 1 1-1/4
Restrained 7 34 34 A4 34 34
=l 34 34 34 34 34
5 3/4 1 -4 | NP NP
Unrestrained 7 34 374 34 1-3/4 3
=l 34 34 34 1 1-3/4

*Not permitied.
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Modeling slabs with variable thickness, loading and soil subgrade
modulus

Skip to end of metadata

Created by Truly Guzman, last modified by Mohamad Ali-Ahmad on Oct 07, 2019

Go to start of metadata

To model slabs with variable thickness and loading in SAFE, it is best to create a base slab which spans the entire floor, then draw slabs of
variable thickness over the base slab to adjust local geometry and loading. Contained-area slabs drawn over the base slab will take precedent. This
applies to every area object except drop-panels. To apply variable loading, assign NONE properties to contained-area slabs, then select Assign >
Load Data to specify load magnitude and direction. When assigning loads to NONE areas in both programs, loads will be added to the exiting
base slab.
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Item

ETABS

SAFE

Shell stiffness
(including any
stiffness modifiers)

The slab object with the smaller
area takes precedence.

If the slab objects have a
stiffness A and the drop panels
(assumed to have a smaller area)
have a stiffness B, then at the
drop panels, the stiffness is B.

“Drop” type slabs take the
highest precedence. If two slabs
are the same type, the slab
object with the smaller area
takes precedence.

If the slab objects have a
stiffness A and the drop panels
(regardless of size) have a
stiffness B, then at the drop
panels, the stiffness is B.

Area/Temperature
Loading

The slab object with the smaller
area takes precedence.

If the slab objects have a loading
A and the drop panels {assumed
to have a smaller area) have a
loading B, then at the drop
panels, the loading is B.

Loading values add together.

If the slab objects have a loading
A and the drop panels have a
loading B, then at the drop
panels, the loading is A+B.

Soil/Area Springs

The slab object with the smaller
area takes precedence.

If the slab objects have soil
spring stiffness A and the drop
panels (assumed to have a
smaller area) have soil spring
stiffness B, then at the drop
panels, the soil spring stiffness is
B.

The soil subgrade modulus with
the higher value will take
precedence.

If the slab objects have soil
subgrade with stiffness A and
the drop panels (regardless of
size) have soil spring stiffness B,
then at the drop panels, the soil
suhgrade stiffness will be the
highest of A and B.

Notes:

1- Shell rigid diaphragm must be explicitly assigned to null areas in ETABS for their loads/additional mass to be included in modal analysis
(seismic mass).

2- For semi-rigid diaphragms, the contained areas are recommended to be assigned with the same structural properties of the base slab in lieu of
null areas. The latter may cause local modes when their load/additional mass are part of the lateral mass source.
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With the rigid diaphragm assumption, distribution of
lateral forces to the vertical elements was made based
on their relative stiffness. This assumption was
adopted in the first generation structural analysis
programs to reduce the computational demand on
memory and processor speed. The lateral forces
calculated for the vertical members at each line could
then be translated into shear forces to be distributed
along the diaphragm at each line.

In some cases, depending on the diaphragm material,
overall proportions, and relative stiffness of vertical
and horizontal elements, it was unclear whether to
assume flexible or rigid behavior. In such cases,
considering results from both flexible and rigid
analyses, designers often “enveloped” the analysis.

With currently available structural analysis software,
flexibility of the diaphragm can be modeled directly
wherever diaphragm flexibility is in question. Bounding
analyses is still valuable to understand the effects of
uncertain stiffnesses on design quantities.
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Bearing Wall Systems

Section 11.2 defines bearing wall systems (under the definition for “wall™)
as systems in which bearing walls support all or major parts of the vertical
load. Presumably, a major portion would be more than 50% of the total
vertical load. Bearing walls are defined as (1) a “metal or wood stud wall
that supports more than 100Ib/linear ft of vertical load in addition to its
own weight,” or (2) a “concrete or masonry wall that supports more than
2001b/linear ft of vertical load in addition to its own weight.” Given this
definition, the likelihood is that most structural walls would be classified as
bearing walls.
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When slabs are supported on beams having ay€,/¢; = 1.0, the beams must be de-
signed for shear forces computed by assuming tributary areas bounded by 45° lines at the
corners of the panels and the centerlines of the panels, as is shown in Fig. 13-92. If the
beams have ay;€,/€; between 0 and 1.0, the shear forces computed from these tributary ar-
eas are multiplied by ay1€2/€1. In such a case, the remainder of the shear must be transmit-
ted to the column by shear in the slab. The ACI Code is silent on how this is to be done. The
most common interpretation involves using two-way shear in the slab between the beams
and one-way shear in the beams, as shown in Fig. 13-93. Frequently, problems are encoun-
tered when ag1€5/€; is less than 1.0, because the two-way shear perimeter is inadequate to
transfer the portion of the shear not transferred by the beams. Thus it is recommended to
select beam sizes such that ey €,/€1 exceeds 1.0 for a two-way slab.
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Coefficient of
Contact surface condition friction pM
Conerete placed monolithically 14 (a)
Concrete placed against hardened concrete
that is clean, free of laitance, and intentionally LOL ®)
roughened to a full amplitude of approximately ’
6 mm
Concrete placed against hardened concrete that
is clean, free of laitance, and not intentionally 0.6% ()
roughened
Concrete placed against as-rolled structural
steel that is clean, free of paint, and with shear o @
transferred across the contact surface by headed ’
studs or by welded deformed bars or wires.

), = 1.0 for normalweight concrete. For lightweight concrete, A is calculated as given
1 192 4, but shall not exceed 0 85.
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Condition Maximum V,
Normalweight concrete 021’4, (a)
placed mogohthlcally or Leastof| (33+0.08£ )4, ®)
placed against hardened @), (b)
concrete intentionally d ( J
roughened to a full amplitude s 114, (c)
of approximately 6
Lesser of 0214, (d)
Other cases (d) and
© 5.54, (e)
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4y Material Property Design Dats

Material Name and Type

Material Name [s300

Material Type [Rebar, Uniaxial

Design Properties for Rebar Materials
Minimum Yield Strength, Fy

Minimum Tensile Strength, Fu

£#y Material Property Design Data

Material Name and Type

Material Name [sa00

Material Type | Rebar, Uniaxial

Design Properties for Rebar Materials
Minimum Yield Strength, Fy
Minimum Tensile Strength, Fu
Expected Yield Strength, Fye
Expected Tensile Strength, Fue

M
M

Expected Yieid Strength, Fye MPa
o0 Ju

Expected Tensile Strength. Fue
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£4y Wall Property Data 4
General Data
Property Name |Wal1 |
Property Type | Specihed e |
Wall Material |c2s | E

Notional Size Data |

Modify/Show Notional Size... |

Modeling Type

| SheaThin

Y
Modifiers (Cumently Defaulty | Modfy/Show .. |
Property Notes | Modify/Show .. |
Property Data
- —
oK | | Cancel |
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iy Slab Property Data

General Data
Property Name |Wafﬁ931}D ‘
Slab Material [czs ~|[-]

Motional Size Data ‘

Modify/Show Notional Size

Modeling Type |5hel-'|'hin v ‘
Modifers (Curertly Defaut) \ Modify/Show |
Propety Notes \ Modify/Show.. |
Property Data
Type Waffle e ‘
Overall Depth mm
Slab Thickness mm
Stem Width at Top mm
Stem Width at Bottom mm
Spacing of Ribs that are Parallel to Slab 1-Axis mm
Spacing of Ribs that are Parallel to Slab 2-Axis mm
ok | [ cancel |

Notional Size Uata

Modeling Type

| Modify/Show Notional Size...

[ ShetThin

=

14y Time Dependent Parameters

Notional Size of Section
@ Auto

(O userdefined

O None

1412 mm
mm
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aalol o aS ol ol oolaiwl » NP oo @ jlade cowl oot dwlre A5 (o Al o ] 0 e aSl 4 g

W Am|5:’> C)Lol

oS o0 398 (6,105 ,L slaSIl Ly x5 4 pladl Define > Load Pattern jgius 5l oslaw! b

pidy Define Load Patterns

*

Loads
Self Weight Auto

Load Type Multiplier Lateral Load I
Mass Other 0 |
Dead || Dead 1 P - =
SDead Dead 0
LiveF Live 1] L -
LiveS Live 1]
LiveP Live 0 | Delete Load |
LiveR Roof Live 0
Qx Seismic 0 User Coefficient
Qy Seismic 0 User Coefficient
Qp ¥ || Seismic 0 ¥ || User Coefficient v | oK | | | |

o0 iy 5 )b (55801 ) o3 A S

L g Seismic g4 51 QZ L g55 5 .098 Dol a0 il Self-Weight Multiplier ., ;> SDead (s, a5 09 <3

s User Coefficient g4 5l aly); sla )b sy 048 wlsesl none i, Auto Lateral Load (5431

Mass Source o =5 A-Y

B9 (o0 dwlne Olab 00 Jb doyd s g 050 )b ggeme b plp leiBle (sl o)) p i SeSs o lesSlu (o

bl ply pleaslo glos ) oy 0 by e b s 5 cnl

Mass Source = Dead + SDead + LiveP+0.2(LiveF+LiveS)+Mass

Define > Mass Source giws 5l oolaiwl b (YA« + asl opol) Conl ool 48,5 a5 jo JulS job @ by cpis )b b aS

gd ooy Ve JSS Gllae (sl o) o2

4§ Mass Source Data

Mass Source Name MsSrct

Mass Source
[] Element Self Mass
[] Additional Mass

Specified Load Patterns

|:| Adjust Diaphragm Lateral Mass to Move Mass Centroid by:

Thiz Ratio of Diaphragm Width in X Direction

This Ratio of Diaphragm VWidth in Y Direction

——
——

*

Mass Multipliers for Load Patterns

Load Pattern

Muttiplier

LiveP 1

Eoer a2 | Delete |
v v

Maco 1

Mass Options

Include Lateral Mass
[] Include Vertical Mass

Lump Lateral Mass at Story Levels

oKk |

| Cancel |
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Bgh oo Jud VY S pille Wo o Julos 4 by e wlelass Define > P-Delta Option giws 5l soliiwl b

4y Preset P-Delta Options

Automation Method

O None

ID Mon-iterative - Based on Mass
@ terative - Based on Loads

terative P-Delta Load Caze

Load Pattern

Scale Factor

LiveF 1

LiveP 1
Lives 1
Shead 12

Cead 1.2

e

Relative Convergence Tolerance

dd
Modify

Delete

| Cancel |

P-Delta Lo oleadass 0,5 Jud VY S

GNS L Y 5 yae ) Y

Sleplass 5 Ll g9 00iiS asine (5,105 ,b V> Define > Load Cases ,giws 3l eoliiwl L ETABS asl s 4o
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kY Load Cases

Load Cases
Load Case Name Load Case Type ~
Dead Linear Static
SDead Linear Static
LiveF Linear Static
LiveS Linear Static EI
LiveP Linear Static
Ox Linear Static
Qy Linear Static
Cnp Linear Static

iz, Cdmii

Click ta:

I Add New Case.. I
Add Copy of Case... |
|
|

|
| Modify/Show Case...
| Delete Case

| Show Load Case Tree... |

GNE L oY VY S

S LS 5 g5 1Y

Gllao 5L5 990 Sla)l S 5 Cow i 29,5 (o0 B gl Lagi a5 098 (o0 plol (pla)l oS 5 bl ojle (AL
D5l oo B 4 YA 4l 0l s ACH

oy eSS et
Selete gl 03, Qx+0.3(Qy+Qz) Q1
seleie gl o) Qy+0.3(Qx+Qz) Q2
ol gl 03] Qxp+0.3(Qy+Qz) Q3
sl gl o3, Qxn+0.3(Qx+Qz) Q4
Swlate gl o) Qyp+0.3(Qx+Qz) Q5
seleie gl o5, Qyn+0.3(Qx+Qz) Q6
Selste gl 03, Qz+0.3(Qx+Qy) Q7
b 1.4 (Dead+SDead) Conl
S NE 1.2 (Dead+SDead)+1.6(LiveF+LiveS+LiveP)+0.5LiveR Con2
S NE 1.2 (Dead+SDead)+0.5(LiveF+LiveS+LiveP)+1.6LiveR Con3
e 1.2 (Dead+SDead)+1.0(LiveF+LiveS+LiveP)+1.0Q1 Con4
S NE 1.2 (Dead+SDead)+1.0(LiveF+LiveS+LiveP)+1.0Q2 Con5
S NE 1.2 (Dead+SDead)+1.0(LiveF+LiveS+LiveP)+1.0Q3 Con6
>,k 1.2 (Dead+SDead)+1.0(LiveF+LiveS+LiveP)+1.0Q4 Con7
e 1.2 (Dead+SDead)+1.0(LiveF+LiveS+LiveP)+1.0Q5 Con8
e 1.2 (Dead+SDead)+1.0(LiveF+LiveS+LiveP)+1.0Q6 Con9
S NE 1.2 (Dead+SDead)+1.0(LiveF+LiveS+LiveP)+1.0Q7 Conl0
b 0.9(Dead+SDead)+1.0Q1 Conll
b 0.9(Dead+SDead)+1.0Q2 Con12
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b 0.9(Dead+SDead)+1.0Q3 Conl3
b 0.9(Dead+SDead)+1.0Q4 Conl4
b 0.9(Dead+SDead)+1.0Q5 Conl5
b 0.9(Dead+SDead)+1.0Q6 Conl6
b 0.9(Dead+SDead)+1.0Q7 Conl7
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Shell Assignment - Diaphragms EE I ii o —

| "

sl i
M sl Ll 4
Diaphragm Assignments ' " i
i i i
None A1 - i
e | ; e i
It 4 EE
{4y Define Diaphragm * EE
= "
i
Diaphragms Click to: E:
| Add MNew Diaphragm | :Ek ________ 1 T — "Ei
| :i
I Modify/Show Diaphragm I i il
I “Delet 0| (44 Diaphragm Data * 5

CH
Diaphragm |D1
Can
Rigidity
) Rigid (® Semi Rigid
| Modify/Show: Defintions.. | |
| 8118 | | Closs ! ! HFoply | = I oK I | Cancel 1l
~ —r—r—]

Semi Rigid gg 5l 651,805 Sl VO JS
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w35 Ll 5| e omles Sl ) Sl s g0 aiib 958 oo 5b 45 5l 6y 4o amles Sl |, Safe 12 F2k File
Swles ol Select Load Cases aaSs g9, SIS LI, &5 5,135 L Y= Export Floor Load Only

4 Options for Export to SAFE [ dy Select Load Cases to Export to SAFE *
Story to Export Load Cases
Story Story1 |

Loads to Export

(® Export Foor Loads Only

() Export Foor Loads and Loads from Above

= Qx
(_J) Export Floor Loads plus Column and Wall Distortions Qy
Qxp
G Qxn
Load Cases and Load Combinations to Export Qyp
| Select Load Cases. . | Dof 13Cases Selected 8’:"
| Select Load Combinations... | 0 of 24 Combos Selected
OK | | Cancel &5
oK | | Cancel
%
e =T e r-"

w3 S slpsafe a4 ail oS >9,5 V8 IS
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dled 0,33 a5 5 550 yus 0 |, LB OK aeSs 155 b ba,b Gl 5l o
I, b, File > Import> Safe F2k File... .ol Import 1,V o8 L SAFE asb, jo SAFE aoliy ,0 ls5/,8.Y
aaled 0235 Slo>1 8 51 o
6 amles JyeS 1wl JUisl 6 8,6 o JIs dlae Slasin 53,55 S culps Slael g 4yl slo s ¥
s ol S 0) awns olaiSl + 0 (Fo,55 S5 cuys b 4 () Uis,) s Jols olicebl Jl W, s
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Assign > Beam Data>Properties Modifier...

05 a3 3y 359 9 oy Mol culpo bl jo asles syl <8 il |, Moment Of Inertia About 3 Axis s .o

Jol> lsbl Define > Beam Properties sgw 5l ol o oy s (55,05 S5 oo Jlosl gl a0 (Y is)y)
— o iz e |y (59,65 S5 LT 50 e gl aelip s 3 opl 4ol oed Jled NO Design s as oS

(99 0 4o 3,553, ) ols valss el

s > yb @S Bllae Lol slas Ko itons poms 5 o 9 10 4 b5 hous pg > ol ploxil s (7 35))
Sl Jr5S sle 0,500, ol 5 el )b e (b 5 e Ol (o0 5 0Bl (o0 Gl BeB0 &S Sl (il )b
9,5 oolaiwl jus

pabul 5l 5 098 (oo Jy5S 05 b sl ST S i S 4 b ML Sl 5 OV gy ¥
Aip=Aip+r —Aip

09l o0 b e
Define > Load Cases>Add New Case...
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B Lood Caze Doty - Monlinear Static T *
Load Caee Mare Loed Caee Cata Holes Load Case Typs
[redtm DML Mociy/Show Noles: Swmne v [ DOesn
Inial Canckins Aaalyms Type
(® Zem Irtial Condtiars - Stert fom Lnstressed Strie 2 Linear
() Cortruafrom Stata at Fnd of Moninear Case 0 Morlnaar Wlow Lk
[ T ® Merlnaar Cracked)
mportant Hota: Loads fom 1his prevaes cese are neudedin the corert O Nenincarflang Tem O“r*ed’_
cang Grosap Ceafficizrt |
Shirkage Shran
Luzds Appied Liplit Sohticn Cantrel
Feres Converpente Toleranre (Faloive)
Lood Hamz Seale Fartor
b |Oed [+ 1.0000 001 |
Slzad = | 1O
LiveF ~ | 1.0000
LiveF. ¥ 10000
Lives | 1.0000
- e
oK Caneed
Ai,D-i—L u."} D s \V Li..u
8 Load Case Data - Nonlinear Static T X
Load Case Name Load Case Data MNotes Load Case Type
‘Deha‘i.D Modify/Show Motes... ‘Smi: V| | Design...
Initial Conditions Analysis Type
@ Zero Inttial Condtions - Start from Unstressed State (O Lnear
(O Continue from State at End of Nonlinear Case (® Nonlinear {Alow Uplift)

| (O Nenlinear (Cracked)

Important Mote: Loads from this previous case are included in the curent O Nerlinear fLong Temn Qad(Ed)_
case Creep Coefficient

Shrinkage Strain

Loads Applied Uplit Solution Cortrol
Force Convergence Tolerance (Relative)
Load Name Scale Factor
b |Dewd <] 1000
SDead ~ | 1.0000
LiveP ~ | 1.0000
- ~

Ajp Sl Gy a5 VA S
o b cpl szl Gglad a5 S ge jo Sl ool (L3, 00 10 b wlie jud cpind b oady )L L A5 0ed oo alaxde
2 a bgrye 2led 5L w5 b sle il b a5l e 10,8 Bl ) Gl 00 Sk 4 bgaye alex s
D9d (oo iy ) yene 3l S

Define>Load Combinations>Add New Combo...
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ﬁ Load Combination Data ? *
General Data
Load Combination Name |Deha.i.L |
Combination Type | Linear Add ~ |
Notes [ Modfy/Show Notes... |
Auto Combination | No

Define Combination of Load Case/Combo Results

Load Name Scale Factor
Defta i.D+L ~|1.

2

Design Selection

[ Strength (Utimate) [ Service - Normal
[ Service - Intial [] Service - Long Tem
OK | | Cancel

Sl 4 by )b S 5 s N S

Slp Saeilys 53 Jol Jad F-0 as Slvsgs gillae ke 0 4 b bgpe () 0 LS 5 Y e O
1398 (o0 dlone 2 b S

A= Ao,0bip + AeoBiss + 4
Gt doz 90 008 (0 dwlne (F0,95 S5 Judow jloolainl b 398 alal) slo JSo s aldS s Lo a5 shiles
slasl Jlasl 51 L8 o0 e 5l 51 oab JSo o oS el [JBaile sl )b ley 4y atsly slo o s £a0mme (393 o)l
& Syt A g, 20050 ()L 51 (56 ST Syt Ay p sl 0 o5 Apg,00 oy 5 e0liial b (sl o3l s
05 sl 51 B aile Coond ol (oo 005 (o) b B aile cond 51 b ST IS o5 Ajp g g 0055 (o)L 5l 5
é}w e QLQ‘aM u_ajim.c uLo.._>Lw 6‘)‘.’ 0.\3)’ &Lﬁ)b JSM)O Yo L}ﬂ‘ﬁ YW k5l5 Cond u_ésl.o.'l.c iy ‘_;).3)[54.3 Ao
abaly i [Eaile 0aij oy sla )b Ceowd 1 LEL S jss (Gl a2S 21 onge 0 1) Jlade ol Sl 4ol &:.,"T)

Sl e 0y sla )l ST S s dlxe

Airs = Dio2s+p — Aip
by § jlaie slome it b Jlo & ooy sln § jladio ol a8 VV-F-Y-VF bl Ap oo b 2ol 1l Apge0
Slade sl oo s (2! 48,5 Lo 10 S gl 51 e olo dus bl o o) Wigds (o cnai b cpi )b aS E0 Lo

o3ld (59, B ake 0iy sl )b 5l Lol JSCo s plod Conl ol (5,8 1555) 09l (oo dls § =2 Lluly plp i deo
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¢ 2

S oo dmlos | Aoy 9 410,00 ulpo It

1
= 0.917

Ato,0 = Ao — A

e® ~ 11 50p  1+50(0.0018) 1+ 50(0.0018)

o P et 4 Sl odd o3 e VA L den o ls g lad el

AtO,OO = /‘{00 (

2
1.83

T 1+50p 1+50(0.0018)

ol o

A= 0'917Ai,D + 1'83AiL,S + Ai,L

el ploa o 55 A p 4 bgrye o 8L o ot Gy ST S s 4 bgyye o8 0 Ay b as e 6 051 oS 5

(Y‘ J.i..:) rg.u.f ga.:).xs ‘) Ai,0.25L+D Ls)‘df)la u.][} w‘ m}l AL,L d.mlaua 6‘;: w‘ ol Q)|3

(O Cortinue from State at End of Nenlinear Case

Important Mote: Loads from this previous case are included in the cument

case
Loads Applied
Load Name Scale Factor
Dead e
SDead o] 1
LiveP o
LiveF ~|0.25
» LiveS B 0.25
- i |

ﬁ Load Case Data - Linear Static ? *
Load Case Name Load Case Data Motes Load Case Type
[Detta i.D+0 251 Madfy/Show Notes .. [static v| [ Desgn..
Initial Conditions Analysis Type
® Zero Initial Conditions - Start from Unstressed State O Linear

O MNenlinear {Allow Uplfty
® Nonlinear (Cracked)
O MNorlinear {Long Term Cracked)

Creep Coefficient

Shrinkage Strain

Uplift Solution Cortrol

Force Convergence Tolerance {Relative)

0.001

OK | | Cancel

Ai02504D & by )15 ,L b Gy pes Yo S8

(V) USS) 09 o0 iy yo5 BB AL g 4 basye 6,05 ,L oS 5 s 5 ol &

Ai,L,s = Ai,o.25L+D -

Aip
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ﬁ Load Combination Data ? >
General Data
Load Combination Name |Del:a.i.5US |
Combination Type | Linear Add ™ |
Notes [ Modfy/Show Notes... |
Auto Combination | No

Define Combination of Load Case/Combo Results

Load Name Scale Factor
b |DettaD+0.250 ~ | 1.0000
Detta i.D ~ [ -1.0000
& b

Design Selection

[ Strength {Utimate) [ Service - Nomal
[ Service - Initial [ Service - Long Term
OK | | Cancel |

ile la)ly 53 4 gy o Jb oS 5 VY ISS
29 g0 S VY KD Bllas jBaile 53 4y bgaye )b oS5 Cals yo

A= 0'917Ai,D + 1'83AiL,S + Ai,L

ﬁ Load Cambination Data ? *
General Data
Load Combination Name |Del:a.Long Tem |
Combination Type | Linear Add ™ |
Notes [ Modfy/Show Notes... |
Auto Combination | No

Define Combination of Load Case/Combo Results

Load Name Scale Factor
Detta i.D ~ | 917

Delta i, SUS v (183
Dettai,L o) 1

Design Selection

O Strength (Utimate) [ Service - Normal
[ Service - Initial [ Service - Long Term
oK | | Cancel
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Do 3 > 4 bgrye b oS 5 VY S
plosl 103 a3l (S0,95 S as by e Olendas . LS foo 5 (6,50, Koo Slamtine g fdoi Olaliis ploxil &
D9 (50

Run > Cracking Analysis Option...
5 L8 (s las e g Sguzme 1yl Jelod gl o 2510 e YT UK Gillas 99250 slo S, (s )
G)L».‘ 9 de}m ‘P‘ L..L?u ) )‘ ool La ML‘).' 409.3; <? oolaw! sML‘ <° u)‘)} 9 8l S " 5 )J‘).' as u.ul.‘ JBL.\? ;...........5 W
Colase (a8 g 5Lid (6l o i i PBlas jlade b o] gl g oud i a5 (6,105 ,L LS 5 g <Y (6l
B 5o anslome IS oyl 4 az i b ol @l (Jg o) (ool sl (o) ol S oo il 1) (s (sl Shes

D9l oo A g3

@ Reinforcement Options For Cracking Analysis 7 *

Reirfarcemert Source
(O User Specified Rebar (Slab Rebar Objects)
® From Finite Blement Based Design

(O Quick Tension Rebar Specification Bar Size mim

Top Reinforcing | |

Bottom Reinforzing | |

Minimum Reinforcing Ratios Used for Cracking Analysis

Tension Reinforcing 0008
Compression Reinforcing 0.0018

oK | | Cancel |

S5 S5 el sl 5l 00 o Mhe @ Loy je Slialais VY IS
(VF o) 05 oo olbusl aali py Loy o1 fir bl 5 00l Clsesl 4ol oyl ay 4z g5 b aolip bawgs  SisecnS Jooe

Madulus of Rupture for Cracked Deflections
{® Program Default {Based on Concrete Slab Design Code)

() User Specified

(NS Jgde iy a5 VY S

13,00 o 3l CSI el 135 5 (o s L6 Define > Materials sy 51 s o gllas cy a5 50 Coond

Modulus-of-rupture value

Created by Mike Abell, |3st medified by Truly Guzman on Jun 21, 2017

ACE: As recommended in the ACI 435R95 report {section 4.3.3),5AFE uses a default modulus-of-rupture value of 4f'_ PSI
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A3l oo Hlaedsl Caz 0 Jg (058 o plsl ACT 435 oy s gudo diloe) ol (o3 ACT asl oyl Gollas jlaie oy
fr = 0.64/f.
(sl N-mm o a>1g) 5,5 eladl User Specified e 5l o1 oMol 4 s (olulpp Glg5 o0 45
g0 0l ad )8 lai o iy Jlo 18w VY e 5logd e dogl aS ol Cowenl 1 ]S gl gus i o5l
Caw! ‘5...:).»....40 JJ[S )J))...m.a)‘ p.a-l‘?a.} L)"‘ el 00 4..3;).’4;)0)...0 GULMJ g ).»‘).: )‘AM U"‘ L‘>r...>|
Run > Automatic Mesh Option...
0] e (YO JS2) 09 g0y o dguzme izl (> (sl o1 0,8heo 5 1o 5l5 Gliee e 5o

Design > Design Preferences...

# Design Preferences ? x

Code | Min. Cover Slabs | Min. Cover Beams | P/T Stress Check

Non-Prestressed Reinforcement

Clear Cover Top {mm}) ab

Clear Cover Bettom {mm) an

Frefemred Bar Size 12 ~
Inner Slab Rebar Layer Layer B

Post-Tensioning
CGS of Tendon Top {mm) 25
CGS of Tendon for Bottom of Exterior Bay {mm) A0
CGS of Tendon for Bottom of Interior Bay {mm}) 25

Minimum Reinforcing

Slab Type for Minimum Reinforcing Two Way

| Reset Tab Defaults |

| OK | | Cancel |

JIs ouls w595 0, Xe o5 a5 YO S

el Cewdy Y8 S illae o 510 g ST lays mls Judos plsil ) o @l b ,) 5 el ploeil Y
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(9 05k e J S g 21k F

g8 J7S 5 el 5o b alie sla o3le 10 Joeme 3190 (Jlod 5 0Bk (od Py sla Bhas 0T Suond (1
U5 curs g ojle 00 drnlone -

Ll oy 55l Jlosl -

S Dope 5 (9,5 S cmlps U5 g el capd s st el o)) -

e i -

@ slojlps (b Sledas -

b g Jelos ol g (ldas ol Slegdass -

(2D 0.25 s oo i po sl (&b S5 -

(o3 IS L les gl bl 5o 50 05le it J 55 -

o5 (ohomn & Sl sl -

oS oo Sz g Alie a4y pladl ol Ay o 2o dnwle Sl YUY Co B g 0g  dewle

GBIl YA+ ael o] dogs Gillas al> o 0l (6l = 5 3280 Judons plosil gaum 0gs p dusline (50,95 S5 culps -

D9 (50
<0 o
\ )‘ﬁu}
YO ”‘Jb

(YA JS8) o oads Mol (Fo,55 S 5 clpd bl il
Select>Select>Object Type...
oS oo pla3l LT Pl 4 s 5 uanns 51 (Wall/Column/Beam/Floor) Ll g4 a5 dws usnw

Wall / Slab: Assign>Shell>Stiffness Modifier...

Sz Sl o 3l plol 5 solu [ 1y 04 5 Slowliee el (51,3bs olaisl b g <d )5 L s Membranel, s g5 oles oo ¥
2,5 Jd s 39y Al sl |y Lo o Jdow o6 )laubl 5 el Lo 4 ¢ g, ol 5l eolasal
Josd BB gy b sl o s Jlol b ens 383 o5 ol o ool 1l aalipy JBlg I8 Gy pa3 led 5 Lx] )5 a8 354 4z g5 28
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Beam / Column: Assign>Framel>Properties Modifier...

Shell Azrigrment - Stiffness Modifiers Shell Assignment - Stiffess Madifiers Frarme Acsignment - fl-c-;.‘c:‘v It pelifiers
Frepertyd Sifiress Mocrens for Anyss Property S1fires Modfier for Aralyas Fregerty/ Siffress Vediiem for fralyes
Membeere 11 Duectian [ embrae 11 Drection Crossuscion isms] Ams
Mambiare 122 Dieetion [ Membrene 22 Dreconn Shear Area i 2 drection ||
Membrere 12 Drection 1 bl ] Sheer Ares in 3 diection ||
e 1 Dt [E— Bervdng 1 Dvction ool Corutar E—
Berdng m22 Drectian ] Bereking 22 Dection FED Morrerd of Ineria sbout 2 axs
Beredng m12 Drection i Bierding 12 Drection Mot of Fatia abeud 3 ans
Shear v13 Disetion 1 Sheorvid Dreston [ Mass 1
Shear 23 Distion L] Stear 23 Do [— Wesrt
o — - —
Wege [ Wegt L
| ok Tlnse | rowiy o | [ome | [reav_ oK Oue | [ feeiy

L 1 Sleylyny s Mo

Ogdy ML?u ‘_gb.’ 6‘ o)L..a ‘_gLa.c‘ L;Q)P J)J w‘ro YA Jiw
aaSs 85 g Modal Ll b s g Modal Cases... 435 Define g4 5 aoge olows oudas -
WS b a0 g Y dib ja oljl 4 laoge slawd ouiS oo euhaii | laoge olaas Modify/Show Cases...
o2 S o A 5o
Maximum MNumber of Maodes |12 |

T PRV K J.:L‘B Py R )‘ LSL@‘ ‘_gl.m)y).s J.».l;u lol?u‘ )‘ o= Yﬁsj.@‘ ‘_ngo%)_» C‘)Z"“"‘ 9 J.».l;u lol?u‘ -
Display>Show Table

oS oo JL8 1) abgyye sle a5 YA S pillae 25 )0 ol e a5

) 3550 ol )3 Con ol axgs BB planel slo ploislo j3 yiing 8590 cnl il XY sbiul) 5o IS cls o Lol slaog ol S 2
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=[] Tables
&-[ I Model
EI--Dﬁnah'sis
- ]Options
|:| Response Spectrum Functions
--|:|T|rr|e History Functions
|:| Load Cases
|:| Load Combinations
E||:| Results
|:| Displacements
|:| Reactions
£ Modal Resulis
Modal Periods and Frequencies

@[] Structure Results
@[] Frame Results
-] 5hell Results

- EnengyVirtual Wark
-] Design

kol srog p alaxde YA S

by M‘}} ).:) )‘).9 L o)L.u (él.o‘ 6&094); ).:..)LO.A

ot L o5t

Modal 2 0.426 i

i b bl el 6l 25 Jooor Billae A3l o pd (ol slaog  polie sl oslitul b aljly cu po dslons -
(\.\.wl.: ) él.l) dalaio ‘5)0 o))J).b 9 I s w) Js.w = AML?LA 0)45 GA-AJ ng).:)‘}nb

) po dmwlxo

To= 0.15 0.15
Ts= 0.7 0.7
S0= 1.1 1.1
S= 1.75 1.75
T=Min (=125 ;) 0.55 0.50
C=A.B.IIR= 0.165 0.165
k=0.5*T+0.75= 1.03 1.00
CoRiFT= 0.165 0.165
KoRriFT= 1.03 1.00

05 o0 0,253 Period.EDB lsic i 04 drles 6
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Olyie <o 1) 0T 5 oS (50 5k 0b 0olel g b gl al o p0 05" (Lol B Lol Bl o a3l alyo (talpg -
) a3 o0 e a3y o po Sl eslaiwl b1y gl o)) (6,108 ,L OV adS s ouiS o0 0,53 LRFS.EDB

oS 0 Uilng
Define >Load Pattern...

o o>y BB Cules )0 oS (oo Ml 392 Jour 4 az g L) ca s i sl o) ) 5l SV TSy e sl s

.w—:—;S
Lael 53,55 S culps Jlasl T

Ol 3l G el (5See 0,8 edlg (6l 05 ) i (b (gl Lasl (S0 65 S ol Jlesl @ pladl als e ol g0
A dales oLl T a dslsl )5 a8 all culps (S ol 5l ceaiel Sbj)l il 4 Az g b g ad> e

S 5 gy 5 plas BRI 51 gy e ol Ky b o azl allas Lo a5 Lo 5,05 S lps -
(3l o 5ozl al el 53 llls (T3 S 0 aSul 4zl L) 950 (o Jlosl - YOl Ll (ptes (S0 )55

o5 wl>Assign>Frame>Properties Modifiers

Frame Assignment - Property Modifiers Frame Assignment - Property Modifiers

Property/Stiffness Modffiers for Analysis Property/Stiffness Modfiers for Analysis
Cross-section {axial) Area Cross-section (axial) Area

Shear Area in 2 direction Shear Area in 2 direction

Shear Area in 3 direction Shear Area in 3 direction

Torsional Constant Torsional Constant

jury ry =] -y -y v v v
(X}
L

Moment of Inertia about 2 axis 7 Moment of Inertia about 2 axis
Momert of Inertia about 3 axis 7 Momert of Inertia about 3 axis
Mass Mass
Weight Weight
ok | | cose | [ Aoy ok | [ ose | [ Aepy
LT Lin 3

o (s 5 oy e sl (F2505 Iy o S

(T JS2) wdl (o0 =Y (50,95 S5 cuypd 5 o (gt 3550 50

Gl &S Hho &y Su03 (5 lake) Cuwloads jslate c N by Ll (F9,05 S5 po Il (F055 ST ey o -
(S dnzlye G Jab ¥V ooz ) meosi 4 WSS obnl (A 55 ddod gl o (ST Glie 4 (5w RalS

las oxus>Assign>Shell>Stiffness Modifiers
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Property/Stiffness Modifiers for Analysis
Membrane f11 Direction
Membrane f22 Direction

Membrane f12 Direction

1l

Bending m11 Direction 0.01
Bending m22 Direction .0
Bending m12 Direction
Shear w13 Direction
Shear w23 Direction

Mass

— — — — [=]
=

Weight

QK Close Apply

LIs (5,55 S5 s T S

Jad) 05 o yslate - YO L -V LT (50,55 S5 as a)lns (F0,55 S5 oy o)l (S0)55 S g -

f. = 0.6/f) =3 MPa

ol 0,95 S5 slojlps (sln G g 08 (o0 poaie <V L Rl o jlgs (5w 2lal o b dul S5, enl 6
(VY JS5) 0,5 pules C)Lol Iy polie

lo,lgs0 wLs>Assign>Shell>Stiffness Modifiers...

Shell Assignment - Stiffness Modifiers

Property/Stiffness Modffiers for Analysis
Membrane f11 Direction
Membrane f22 Direction 70
Membrane f12 Direction
Bending m11 Direction
Bending m22 Direction
Bending m12 Direction
Shear v13 Direction
Shear v23 Direction

Mass

Weight

o] [ ] [om ]
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= |
[y Load Combinations - s o F= : = .
4y Load Combination Data i
Combinations Click to:
General Data
Conel
Cu:Z A I Add New Comt:a Load Combination Name ‘WalCrac'kCﬂnbn |
Concd
Conocd | #cld Cepy of Comba.- Combination Type ‘ Envelope V|
Concd e ”
Conch | Madify/Shaw Combao. Notes | Modify/Show Notes... |
ConcT P
Concl | Delete Comba Auto Combination ‘ No
Conch
Conc10
Concl1 | Add Defaut Design Combos Define Combination of Load Case/Combo Results
Concl2 9 =
Conc13 | ; T = Load Name Scale Factor fs
Conc14 Convert Combaos to Nonlinear Cas
Comel5 v ' Conc2 1 Add
Concd 1 ¥
= Conch 1 :
KR Conch 1
- A B
A Dead | 1 3
% >
[ ok | [ cancel |
TS P

sl ojlo slajlend (59,05 S5 (omyp ln g b S 5 YT S

w5 (o0 oy |y Bl (sla a5 S22 adlge Cunig ST oS o Julow 1) 03l LG (398 5L S 5 i a5l
(N-mm) oy Sl sl axlg 4 azgi b o ¥F S Billas 5 o (o0 )Lid 1) FO ol o 51 ey jekain ol @
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Load Case/Load Combination/Modal Case
() Case (® Combo () Mode

WallCrackCombo ~ || Absolute Max ~

Compornent Type

Shell Stresses ~ | | Vizible Face ~
Component

Q) 511 () SMax 513

@® 522 ) SMin O 523

O 512 O svM O SMaxv
Contour Appearance

Contour Option Display on Undeformed Shape ~

[ Show Lines

Show Fill Transparency 0.0 w

[1 Show Values

Contour Values

Min/Max Range |-3 | |3 MPa
Contour Averaging at Nodes By Selected Groups ~ || Groups...
Scaling
Ok Close Apply

b lgzs (59,55 S5 oy ¥F IS0

EAWA ).3‘).3 L:o)l}.{o L:,-’LQ) ;0)5.‘} &5)_\ w).,a ‘O..:“)_‘\LZ.}MOQJ? J).: Ca.:.&bj)é L:o)|9.lo r:Loqu.)s.wu’.AA.b})Lc
sl dalsss 1 1 (6,86 imel b s Comdg o)y diwd 00,55 S 5 b lgso aSul 4 4z g5 b 09 o 2L

Isazte Bl (59,95 S 5 o pd pdd DHgo ;0 ow) 2 Geed Dbl 03,95 S 5 b jles il Sed &S S50y S
2yl
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)lg0 (59,95 S5 (g YO JS&

ol oo g dimy abiiol 51X
(CUHT Sils 0llS L) S (oo smpn |y 051800 (oo
Display> Show Tables> Analysis>Results>Displacements>Diaphragm Max/Avg Drifts
Iy sl o) ;b &Yl Lads g 00,5 conl, SIS Load Case/Combo ;ygiw w59, 09 (oo b a5 (saaz o, 5o
Sz Oled 50 151808 ) p 390 SLiwly o sl TtEM (g jo a5 0iS cds (W58 A3l 32 ) @S oo S

il o ol

2 phate 1y o3le plg (oo X sbiwl) 10 (6,135 ,L @V 51 (o bgyye (6500 Jlade 5l (g piir b g YF JSS  axgi b
(VA aeb il G VYY) o) b5 L
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Load
Story 3ze/Comb ftem Max Dirift Awvg Drift Ratio
b |Storys aQy Diaph D1Y 0.002709 0.002447 1.107
Story4 Qp  |DiaphD1Y 0.002523 0.002449 103
Story4 Qn  |DiaphD1Y 0.002898 0.002443 1186
Story3 Qy Diaph D1Y 0.002547 0.002295 111
Story3 Qp  |DiaphD1Y 0.002366 0.0023 1029
Story3 Qn  |DiaphD1Y 0.002728 0.002291 1191
Story2 Qy Diaph D1 Y 0.001991 0.00179 1112
Story2 Qp  |DiaphD1Y 0.001845 0.001794 1028
» Qx Diaph D1 X 0.005895 0.005329 1.106
Story4 Qe  |DiaphD1X 0.006392 0.005375 1.189
Story4 @n  |Diaph D1X 0.005399 0.005284 1022
Story3 Qx Diaph D1 X 0.005407 0.004845 1115
Story3 Qe  |DiaphD1X 0.005895 0.004893 1.205
Story3 @n  |Diaph D1X 0.004919 0.004805 1024
Story2 Qx Diaph D1 X 0.004118 0.003674 1121

iz ool oy TF JSS

SYYSY an YA el il Gillae (Gl Jled i) sl 035k s 4 4255 L ol (sinoll 2 oy sl -
@ axg b oS s ol glas)) 1) e Job 55 oo ey 35 10 Coons o sl dilas Slaws obs,l gl | Con8 ¥
2 50 ole guxel oo (plply 0 dales ¥l i Jlie ol o be ailes slawy dads glaiyl g B)b jo j0 o jlgss Job

e S DL (B0 (o) 2 Sl Bk (o0 il B 00)d TO Sl A SlEL (B Glie 0B GaleS VY L pl Bl 9
Display> Show Tables> Analysis>Results>Structure Results>Story Forces

bl ol el )3 s (o0 )18 (o) 2 Sjg0 JuuST 0l (o a0 (B Cond (o) 2 Sln ) @S e
27 W) S oo e Ay pe 0 Lol (el o po S o o aaleS VY pln oS (nl bl et
(23 oo (el po Jlosl & (555 a5 051805 (b g i yo JpuS Sl

S (o8 518 (o p 90 5 e 5l 03l b (Bl 3 e 5l g3 polie WS sl Al o pS e -
Display> Show Tables> Analysis>Results>Displacements>Story Max/Avg Displacement

il pln wdl (o VY s lib pled )0 g Liwl) 90 10 (glp Cad (] a5 das oo (Lid polie (g

Amax
A= (2 2 <
J (1.2Aa,,g) =

2o o o)l canlio + B (B8 i Cu3S e g ke cplple

Ol pbaiel slo o3l jo el (BUS o 35 e j0 Cdy o S ol og chom pbaie 4 dax i b0 [ Y
25 oo el (M sla aligS yo ]S

oS (o0 0,33 ooz DFIft.EDB (ylgie cow a3y colpo 4 gumel co o Jlesl gan 1y L6 -
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D (g0 ool 35 Sy S5 sl b L (Soyt S calye les I -
T oelS oo 4> QY 5 OX sl o3 o)l slp 1y ey 350 sl mlmle ) e 5| Jdos plol 1 ey -

Display> Show Tables> Analysis>Results>Displacements>Diaphragm Center of Mass
Displacements

Export to an;5 Jgax 59, cowly S b s 035 0 Jleé 1, QY gX « Load/Case Combo g o
YA aol oyl ollae oS o ol 1) Excel

0.025h
Ag= CyA,< 0.025h - Ay < ———< —> A, < 0.005h
Cq(=5)
Al oo ks g0 il glis | B as
Story | Diaphragm | Load Case/Combo Ux vy Uall
Story4 D1 Qx 49.95 64.7
Story3 D1 Qx| 32.647 49.8
Story2 D1 Qx| 16.886 32.2
Story1 D1 Qx 4.962 16
Story4 D1 Qy 24.011 64.7
Story3 D1 Qy 15.959 49.8
Story2 D1 Qy 8.438 32.2
Story1 D1 Qy 2.554 16
mm mm mm

g (o0 (bl camlio a0 Gl Gl
syt sloy oo b Sladii
gl ads ool V.Y oael oo 4 azg b weo,S o jb lateralledb LG @ loose . ol oy Slas/ -

OV o dn 0 ]l Gl (o0 oS (oo JS0 L) sam S e 005 Rl VY )l ) L L L e 61350
(VY JS5) oS 015 o Scale Factor v pw 55 5,135 ,L

calpo do o ol o el oY & jganl pi 4o el Cwty (LSS Lasl oles Judody i y0 435 culps oy polie 4 dzgi b Jle ol 0 30
23,5 Jlis J55S Jolhe ple s 9 Si9d Dol 35
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14y Load Case Data X
General
Load Case MName | | Design... |
Load Case Type | Linear Static “| | Notes.. |
Exclude Objects in this Group | Mot Applicable
Mass Source | MsSrc

P-Delta/Nonlinear Stifness

(®) Use Preset P-Delta Settings hterative based on loads Modfy/Show
(O Use Nonlinear Case (Loads at End of Case NOT Included)

Nenlinear Case |

Loads Applied

Load Type Load Name Scale Factor

Delete

G ,L Y o el o o Jlesl XYY S

Pier s 9 coé; ul;w‘ |) ksw).: Lgl.b)b.‘a'é )‘ r:l..\S S Pier [ ] uoLA.«.?‘ 6‘ﬁ u.w/..: d[ﬁ)/}gdpier [ w).y—

S WS e oolaul o b g les avain aid Glp 6 )S ez il Al e oo olais ol eSS

o 48,5 L )0 Iizme slo PIF Ll sy g 958 (oo iy o PIET S O j90 4 WS al>po (nl 5o IS L Jlos a5 0
Assign>Shell>Pier Labels...

Pier aw 4 al> 0 opl ;0) swsles SIS Modify/Show Definitions 4sSs (g5, « i o cons p <y 15 5l

(o035

,lg0 (5,108 oz 5 YA IS
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Design>Shear Wall Design>View/Revise Preferences...

‘0)99 )))Lv )|5.1\> pw LY Joyj.a (@l}ul} LS’LAj))" w]@) Cd u.u]o lDL..)‘ )J NE G- WL».A uLo...la,.u )...u.....) yw
(Y o) sl oals 2ol (lgss )b & 5,5 Cos ) Utilization Factor oo g oo,e ooy oV38 00,

|4y Shear Wall Design Preferences for ACI 318-14 X
tem Description
e o | i -
03 | Rebar Material 5400 a UniformiSection Designer section
04 | Rebar Shear Material 5300
05 | Design System Rho 1
06 | Design System Sds 05
07 |Importance Factor 1
08 |System Cd 25
09 |Phi (Tension Cortrolled) 05
10 | Phi {Compression Controlled) 065
11 | Phi {Shear and/or Torsion) 075
12 | Phi {Shear Seismic) 06
13 | Pmax Factor 0.8
14 | Number of Curves 24
15 | Number of Points 1
16 |Edge Design PT-Max 006
17 |Edge Design PC-Max 0.04
18 | Section Design |P-Max 0.04
¥ 18 | Section Design IP-Min Explanation of Color Coding for Values
20 | Utilization Factor Limit 1 % Blue: Default Value
Black: Mot a Default Value
Set To Default Values Reset To Previous Values
attems | [ selctedtems | [ aitems | [ selctedtems | Red: :f;“;‘r:;:‘:z;;“:r:‘ ged during

B Sl b 5 S Slondas YA S

5 o 61 ) sl il e polie el g o alog e b Shas o515 & s ) 0 4
4.1>).A U"‘ )‘ o ol oo ools wbls D Cans oW w‘ L?L».D‘ o 09....; )5.'4.».4 d.ol.a)J L)")B d“"’ aal ‘S)LA.A 9 (T/C ws)
o5 on J5 1, e (35 Sl

Design>Shear Wall Design>Select Design Combination...

sas 3,13 Design Combinations cud ;o ¢ Jsl cond ;0 oo iy 25 (5,138 ,b LS 5 adS a5 oS o J 0S8

sk
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pdy Design Load Combinations Selection - Wall Design H
Swength
Choose Combinations
List of Combinations Design Combinations
ol 3
oz Conc?
a3 Coned
Q4 Coned
as ‘ Conch
[rii] > Conch
o7 Conc?
WallCrackCombo « ConeB
= -
Conc10
Conel
Cong12
Conc13
Concld L2
OK | ‘ Cancel

o oles Fhb bl cus s s ¥ IS
b 5 el plnil 5 s jledo plpi Sl i P

p3Y s Gravity g5 5l o3sn ool 3o by 9 b g aSol 4 425 b layd 5 o gt 4 bgy o Clonisr 25—

(i 1) b c09d (ood dmslons Ll )0 0ad Sloml glog s 1525) 098 Jlad Wil (sl (ool (g 0y SIS 435 s
Jolas Lacl (plogd oo dlpiiny Jlo 2 0 aisd (6 )08 Dguls 039 O ygo s Sl p3Y (6 1080 Ko al> 0 o S

Sl U slo 5 b NONE (sl 15 1ol 45 598 30) Lisgies g b3 Sl 5 a9 J S Lawgie 6,y S5 sl
Design>Overwrite Design :xigs )5 >,k Jeads 5l il 60l g 5 (6,105 ,L alos] Bun b 1ads a5 oS

:(No Design «,;5 ol g Procedure

Design>Concrete Frame Design>View/Revise Overwrite
ol pedle s caslie Bloudas ple oS o ol SWay Intermediate g5 Framing Type .. 4
s | b S Slelais
Design>Concrete Frame Design>View/Revise Preferences...

i u-“] aS 0 CB0 odl S Slewda g0y 40 lakd aiius caslie B8 o Sleudan Ll aied S g
b ouls ol ACI 318-14 b

oS oo Sl 1 05l g aSo b F5 ols 105 b 598 wladass plxil 5l oy .l gl Lol il 5 el ol -

5 s 955 o0 dpogh 3,5 weblyn b g 5 Wy >Lb 4y pladl i aaSs b gie b 5 b SAft + FE 0S|y s
25 sl Oy g iy 5o Check el (o, Jld L T Jsb 0, 8hs o (52 ()0

axg L General g, 5,38 o Lol jo g e >k 6lp Loy, aw ETABS sl i sl lpo 1L -
L ULTL 6lajlses sl a5 anled azgh wik (oo (20 sb)led (Fob (h9) Cnyie «Beds 6,159,800 (el 4
thio b 255 sl lgo | Simplified T/C Design s, s Uniform i, .o S eslasl General i, 5l sl

g el (o03 QLS (pl ggdge b (il ooly (SoSx g o oy, 51 o o JolS 20 all (o0 eslinnl BB CSleiSs
eled anzlpe QLS calu b8 a5 b (s gl o5l (P ib (cages oS @ )5 s, ) a5 sl s oo b
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(D 0.25 b s o sl oo S35

s (b 5 4 pldl Al o ol 5 Sl Sl e b 553 ezl I (e s Sl 4 a4z b
Iy (% p s Jlie cpl 50) 5 )b e lo Gldl (o (Gl VO ies S5 R85 ks e b ol b
U"‘ B ;.\...ul) )‘Jf).ula 63‘9.9 6‘ o)lg: o ‘5...:).' du)‘yo ADM)‘ C)l.‘> wo.‘> 6‘,) Sl uio.n Sy90 U"‘ \A-A-S‘SQ J)HS

Sl o Ha8 o ]S ol 5l e
(k) U Ll sl Lwly s 50 o5l Jituw J S A

5o Sge 258 Ol 095 4 oSl Sl o sl Lol Gl Sl g 2isd Jolod 5 (6515 ez L
18.10.5.2 Unless a more detailed analysis is perfonmed, E18.10.5.2 Where wall sections infersect to form L-,
effective flange widths of flanged sections shall extend from T-, C-, or other cross-sectional shapes, the inflnence of the
the face of the web a distance egual to the lesser of cne-half flange cn the behavior of the wall should be considered by
the distance to an adjacent wall web and 23 percent of the selecting appropnate flange widths. Tests (Wallace 19963
total wall height above the section under consideration. show that effective flange width mereases with increasing
drift level and the effectivensss of a flange in compression

differs from that for a flange in tension. The value nsed for
the effectve compression flange width has little effect on

the strength and deformation capacity of the wall; therefore,
to siplify design, a single value of effective fange width
based on an estimate of the effective tension flange width is
used in both tension and compressicn.
b alols cral jieS lade ojlasl ay ol azg 5l ol S L slalgro pdai) Jlall ablio jo Jb Sge (o, i pl @illao
Oy S 3ubd Judow aSST Ko 09 Gl anlllas 0,90 ahhie YU jlass S elai )l as )0 YO 5 jgle (sl o3l Sl
el 1y el ol 5Ls 0,90 80 (558! oy Judos duoy oo 5 4 g conl Slads o ol g5l ooly aSul 4y 4z g5 L o5

3 ilad i |yl ) e (sl 1) 5 sl (95 g ol (e &) 5 & 35 50 5 o)l
St L) o (o5t S8 e cyg0r 5 slalss b J S Gl (hny i oS | b il ¢ sl 30
s 28 5o g 85 5 )5 ke b 5l sm + S et L S S e g | (L
Gt e Gl D550 50 S cnl oS U558 ) )l (b o B sle g 00,5 Jake p 99 5 g il (e
Ol hgd> D9 b (o (elaiel (o) 2 (rlp ogdle all Coenl Pl Sl (Seo 20y Ve Sl s 4 Lo (gt a0y
L o5 Sk pis Y (G 2hb b 3gd (o0 oy Jlopp 4 Sl 0ad dpogi oLl (B by 56 b gt
5Ll s 55 1) LT (958 0 b il 2alS (See 0o b (i 8 sla G 95 i 45 wled 50 S0y 5590
Ded (653 ol (6,8 Slalgal ol alauly 4 L§->11,J¢> ailyd o saioes 5L aes oS lie

Slojles 0550 po Ly 5o gl JEne &j50 @ (5550 Oledl S5 5 o lses alilaz (6135 Gy ()8 0,505, S plsre & b nl L *
e (oo dngd A laz L S Lul) o gl cdlowyl jo 0gd oo dpogs WL
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=L 2 2
ber = ber <
be{ = [hi of I’r ef hTw
e 4 o P e ——

:

51 52

slosle Jlws oo (oye hym Fr IS0

oS oo 4 LateralTorsion.EDB el 4y S asens S L6

13,00 oo Lo ACT ael ol aSol @ as g5 b iy ot oMo/ oy dales -

22.7.3.2 In a statically indeterminate structure where T, =
& T, and a reduction of T, can occur due to redistribution of
internal forces after torsional cracking, it shall be permitted
to reduce T, to ¢ T;,. where the cracking torsion T, is calcu-
lated in accordance with 22.7.5.

S S5 S Pl s e I gk el oo ©)le 4 a8l (gileen g9 5l 15 i &SS9 0
i 8,559, ool (65ke 00ls (6l (somiive Sl 58l 05 50 ols LnalS BTy a1y adaiie Ty lgs (oo wil axils 349
g Ty alamdo 015 o 1,8 solaiwl 5,90 Mad a5 gy (abl oo o pud )L, SO S > 10) sl ooiis o
st e Sl Syl 0gd K05 BTy a4 Sen 9> b Ty a5 sl (6958 & (i (S5 (Bl pd i
9 Jelod ojle ol G s (@l (9) 08 (o0 PR ) Rlp (i (B o pd dal polaie (nl 4 el
Torsion e 5l oS o SIS |y Shear auss wo,S col, SIS b5 51 plaS ,o (55, 09b 0 )b

oS oo olus |, Ty & OT e Lapacity

Torsic

Torsion Threshold Critical Conc.A
T“ 'mT“., 'm'Tn- AI:F
N-mm N-mm N-mm mm
T3649651.02 | 7230118.25 | 26920473.01 20250
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) e 3 5 03,5 Gl lsazme | 5 03,8 )15 oa a8 o 51, ojle iy it o Mof o 5 Jlac) -
Assign>Frame>Properties Modifiers...

oS oo 8 a5 50 00l acwle Slaie 4y Tosional Constant ol 4 pladl

T & BTer o 03,5 (b s el | o3 lowme oo ool oy Dol 51 o woitins 2255 (> b -

loxguQﬁ.@Q.llﬁ.é)o05.;2';‘5@6&.’;‘;ISLLbjW‘mlggiio)‘i&gwwldfs';)y)a.mjsagto
53 S5 oL sl oI5

W (pl o 1oy (homn slas Koo Colae Ygoro b aeils (cdomy £5b U ogd (o0 ploxil Lo 4dS' (sl 393 0,
ol g5 BB lade s o5l

@y baid 358 gy 5 0Bl (o0 ) plp (cdamy Coli oo Wl ol g5 5l pdamy 45 (Sy50 50 Cenl 55510k @ p3Y
b 8 cl S ;MT Ol Jlo b by oo b yud 50 0550 ol 0,0 00,15 (gl yioms
JIs 2l >k 0
1398 (o0 el 5 20 4 Bly s (b sl o)) pias b 5l o Al e 0l s
SAFE ,s Jls >,k sl ETABS I 5,5 4 -
S5 S5 wlr g sildae lelas -
a8,lSe Shr sl g Py oslwl colas J s -
b layly i )l -
b s Jelos ol g el -
S (gl )adsbgs b J S -
SAFE ;s Jls (=)l 51y ETABS I >, a5 -)
JolS ¥ al> o s LRFS.EDB LG a1 05,0 )b a2yl aSl jl s o o oo F2K 25,5 -
(ol ool Judow L) 0 0 SAFE (gl (2,5 (58,5 & pladl 5 e el
File>Export> Story As SAFE V.12 F2K...

Select Load 4.5s s, SIS L R Sl {®) Export Floor Loads and Loads from Above ,

Select aSs 59, S L opl pogdle .ol suds Sl (5,135 L &Vl adS a5 (uiS o Jool> bl Cases...

Jol> sl 55 0l cy o5 L3 slo o5 j0 a5 Sl > (6,138, wluS 5 o bl 5l Load Combination
Swles 0,053 SLAB_Final.F2k lgie cox olgsds pus o 1) Jol> b ogles
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iy Ortions for Export te SOFE * dy Select Load Casesto Expart to SAFE 2 i} Select Lond Cambos to Export to S4FE B
Storyio Bt Load Caminetiors
Sy Syl ~
Laadzta Bxport

0 Expent Foor Leads (i
@ Eaporl Aoor Loadz ard Loada fram Abeva
2 Eupat Foor Laads phus Colarn and Wil Dirartons

Load Caeas and Laad Combinations to Bport

Select Load Cases | 13 of 13 Casas Selecied
Selecd Load Combinatione... | M of 57 Cembos Selocted

o] [Tl

SAFE I Jlo @LQ.» gg'>|).|c 6‘)—.’ ‘5?5)5 Ad wa;

Jaie SAFE 45 ol 5L Slids g o)y 0590 dibs ) (glog i aS 058 S0 ) e <o b ol 2k sl

G pacw 3 50 50 Cewl ;3 4 p3Y all o yue (51300 g6 L 0 pdy Do JWl pl ST (gl cpl ogdle 05l

JE & o3 5 8,5 b o188 slog s sl 8 1y 1o o5 o ikl 51 3 ) i o 5 85 5 J

M‘\b ‘5....’)).'4.1)[...: d)l.l...a)‘)gd...l.v GLE d.va.) lej.a (f‘)b Pow yo uojﬁ U"‘ W‘QSMUS.JM 6‘ o)).l LSLQBJ""

b

S 5o Olery8 1) 8 Cand 5l ouds ags b 55 jas SAFE asb, o SAFE by + F2k Kl o5 0l -
File > Import > SAFE .F2k File...

S5 gy anlol 51 LB g ol 0,53 5l ey 0uiS 0,053 olgsds sws ,o SLAB_Final.FDB ol a1, LB Slgs1,8 51 e

D98 S gl bawgi sl o)) la)l sl como (izren 9 6 )NTL LS 5 g Y wllas iy pai ol g

255 planil e &g 4 Sl S 6l Wb s ol ik

S5 S5 alyd g 6sbadae lakass alowl Y

SAFE ,5 abolio ol saze ciyyo5 45 5Ls cas plowl ETABS jo lo o (gjludoe aSol @y a5 b o abldo iy poi | oo o
Ol a2l ol BB o b, sl a as g b ogd (oo dnogi aeliy (o Cu b ol S wis e il
s 31 Ol w8l (o alose 5o il (b 43S o Jub

Define >Beam Properties...

Jus b os,5 s 1, No Design 435 Modify/Show Properties... asSs g, SIS g o5 51 S0 0 Ol b

o (22 a5l o gt (6T 09
(Gl 03 s (F1,0) ETABS L ) o0y iy pa3 00,95 S 5 lpo o 5 (b5 Lael (53,65 S5 culpo Jlos]-

Db Jlosl la JIs gla ygiw o 5 a5 ol o cpl sl o3V cpl by 0sd sod Jiiie SAFE aaliy 4 Silogil & g0 4

Aol o 2l g Sl gl aid) I ol po Bllhe ol
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Sl 5 e yebaie pl s 0gd oo Jlesl lo sies lo S5 4y 0l jelaie « YO ply L S, S5 oo
(FY JS8) 058 (oo Jlosl abgy po i po ) e 51 (Bl 5 o5 slo o) I

Assign > Slab Data> Property Modifiers...

g oo Jlasl JloM1T, M22 o ailgs ) i ool

e

ﬂ Property/Stiffness Modification Factors

Property/Stiffness Modifiers for Analysis
Membrane f11 Direction
Membrane f22 Direction

Membrane 12 Direction

P

= =1=1r=1r=lr=r=1r—=1r—
P
| |
~a

Bending m11 Direction
Bending m22 Direction
Bending m12 Direction
Shear v13 Direction
Shear v23 Direction
Weight

Ok | | Cancel |

JIs s e 3ol FY IS

IRl Sln (Fabjloe SIS 23S S )8 09d (oo Jlesl (eSS g Dl L) (50,05 S5 ca s
sl curs Jloel jlon; (o o cnlio o en Jloel g Cens (03 sl Gl (59,65 S5 ulp2
LQ).».: «.)L?L».:‘ )‘ o Sl 00 ).E.._é).»o =9 Jlo G:Lw}«.o.b

Assign>Beam Data>Property Modifiers...

(FY JS8) 055 (oo Jlosl T jsmme Joo (omyial los alyo &1 oty

ﬂ Property/Stiffness Medification Factors x

Property/Stiffness Modffiers for Analysis
Cross-section (axial) Area
Shear Area in 2 direction
Shear Area in 3 direction
Torsional Constant
Moment of Inertia about 2 axis

Moment of Inertia about 3 axis 35

Slall=1=1=1=]1]=
)

Weight

ox

b 5 oa (S Mol FY S
e Sl (g QUG5 ey 5 e 4 5 b (g 9590 50

Assign>Column/Brace Data>Properties Modifiers...
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098 oo Jlosl ¥ 5 ¥ j9me Jso gyl Glos 4 0¥ oo

ﬁ Property/Stiffness Modification Factors =

Property/Stiffness Modffiers for Analysis
Crosssection (axial) Area
Shear Area in 2 direction
Shear Area in 3 direction
Torsional Constant
Moment of Inertia about 2 a:ds
Momert of Inertia about 3 axs

Weight

— =] =] — — — —
~ ~
b

OK | | Cancel |

-

s seas s Lol FE IS

wra [RUIPRCOW-Y 00)55 sSJ.J b)‘ybmk}déb r:lf).b om]t}osdqw)))mc\.}ybﬁ‘smf 6L®)|yé Syge 4o
(FO JSi) 00,5 oo Jlos! f11 addge a4 - Y0

Assign>Wall/Ramp Data>Properties Modifiers...

|

Property,/Stiffness Maodffiers for Analysis
Membrane f11 Direction
Membrane f22 Direction 35
Membrane f12 Direction
Bending m11 Direction
Bending m22 Direction
Bending m12 Direction
Shear w13 Direction
Shear v23 Direction

Weight

oK Cancel

Sgh oo bl Jae Jal i g asl ol Slagrle o azg5 b pdls [olS ol Lol g5 pkici =
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20.5.1.3.1 Nonprestressed cast-in-place concrete members
shall have specified concrete cover for reinforcement at least

that given in Table 20.5.1.3.1.

Table 20.5.1.3.1—Specified concrete cover for
cast-in-place nonprestressed concrete members

Specified
cover,
Concrete exposure Member Reinforcement mm
Cast against and
permanently in All All 75
contact with ground
No. 19 through 50
Exposed to weather No. 57 bars
or In contact with All No. 16 bar, MW200
ground or MD200 wire, and | 40
smaller
NWo. 43 and No. 57
40
Slabs, joists, bars
and walls
Not exposed to Wo. 36 bar and 20
- smaller
weather or in
contact with ground Beams, Primary
columns, reinforcement, 20
pedestals, and | stitrups, ties, spirals,
tension ties and hoops

B 11 JIs 1315 oI55 (oo sl a8 Y5 51 00 5, 8heo 0500 5 S ST b 0l31 slsp 5 pme po 15 4Kl &y agi b
w35 Design oo sl il 8,5 Jlai 55 e (hea Yo nln 1) o8 Cul Yo 0l 5o 10855 S5 5 e (L Yo il
(57 JS) oS o0 S5 ;0 VF 1) s g o Klie 0 pei oS o sl |, Design Preferences

] Design Preferences ? X

Code | Min. Cover Slabs | Min. Cover Beams = P/T Stress Check

Mon-Prestressed Reinforcement

Clear Cover Top {mm) o

Clear Cover Bottom (mm) an

Prefemed Bar Size 14 ~

Inner Slab Rebar Layer Layer B
Post-Tensioning

CGS of Tendon Top {mm) 25

CGS of Tendon for Bottom of Exterior Bay (mm) 40

CGS of Tendon for Bottom of Interior Bay {mm} 25
Minimum Reinforcing

Slab Type for Minimum Reinfarcing Two Way

| OK | | Cancel |

b o idg eedas F7 S
Al ged by gl colB PMlal 4 (g5l (oS sod (b 1) s Al 4y ax g

as § b o ol oy b Job jieS o3l VO 51 piieo bs e oIl Conl oo dogs Lo o oI filu> ki
3o Gk 5l Mol pl sl o sy yio 5lw FO L pl s ojlail cpl e Ve sgas ailes (5,8 L g Jle opl gl 045
(FY JS8) 058 0 pll Automatic Slab Mesh Option 45 5 Run
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B Automatic Slab Mesh Options ? *

Mesh Options

(@ Use Rectangular Mesh
Use Localized Meshing

Merge Points Where Possible
() None

Mesh Size
Approximate Maximum Mesh Size 0.65 m

Reset Defaults

oK Cancel

G e ojlasl Alal FY S

a5 S5 g oS 0 ol |, Advanced Modeling Option... 4535 Run ssie 3,0 51 cpl 5 ogdle

20 Plate - UZ, RX, RY On
(FA US8) 098 plodil (gom s O jgo 4 Judodi B4 yls (o0 0] o h‘ll

§#] Advanced Modeling Options ? s

Active Degrees of Freedom
[] 2D Plate - UZ. BX. RY Only

Add Special Constraint

[] Add Rigid Diaphragm Constraint at Top of Columns and Walls Above

Vertical Offset Modeling

Ignore Vertical Offsets in Non PAT Models

OK | | Cancel

Sibdae slo a5 ple oulas FA JS2
A3,Ss G sl )les o b (g SLbL g (g ojlal colis J s Y

Gw)).:l.:wl.?ba UJ‘ OO b_talS 54.l.>).a L)"‘ ) W u.:L?u_w‘ 4h ).3‘).3 JLAJ‘ 6)4.\4 J&ud.'a.:Lo u,uL».u‘).v )49.1 L’>'>‘9J o)‘d.:‘
.)9...» uL?L..s‘fj.: ‘LSM")J)LQ d.]a.u‘ad;w‘uimﬁ(_g)i:é Q_?‘?" OB)LC \)9*.4‘50&5.»)).» QYLAJ‘JJLA)\) 43).]4&) U’“")"
D ploeil (61350 SLoS 5 pled gl b iy lo JyuS a5 Canl (S5 4 p3Y 0l dales adtie

alad 51 (5 485 o Coaglin ACH asbs ol llas 2353 oo plosl alo o 53 (o S5 (ol A i 25

YY (- .
: QSM <* ML?LO )

el odd gy w3 Vo ol s b do 15 5 Ceaglie e iuldl el i il o 32
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22.5.5.1 For nonprestressed members without axial force,
V. shall be calculated by:

v, =0.17A/fb,d (225.5.1)

s s oglie 1o Lo a5 e L oS 05 85 b g (ol Lt 5 o a5 abSs i S sl

V. = 0.17\/f .b,,d = 0.17 * 5 *

100 + 120
(—) (270) = 25.2KN - @V. = 19 KN/m

D98 oo S8 68,0 SlS 5 LSSy sl 295 V23 V13 ls adlge Jdos 5l ey

Display>Show Slab Forces/Stresses...

&
Load Case./Load Combination Component Type
(O Load Case (® Resultant Forces () Stresses Top Face
(@ Load Combination ShearEnvelope | | Max v () Stresses Midsurface () Stresses Bottom Face
Display Options Component
(®) Display Contours on Undeformed Shape Ol O M1 ® V13
(O) Display Contours on Deformed Shape QO F22 O m22 [@R"7x]
(C) Display Contours in Extruded Form O Fi12 (@R} () VMax
Sealing ) FMax ) MMax
) FMin ) MMin
O Fum

Contour Averaging at Nodes

O None
(® by Objects
(O by Selected Groups

Contour Range

Minimum kMs/m Apply Close
Manum v

2 >y Bl Glp b az 5 o a8 laSh Gy Jus TS

o G g (PPl e b (oo edlitul 0ad (08 gl (Al il @) 8,50 b J 5SSl gy !
g 18,5 L5 )5 g8 oS e 4l sl wuS el lone e 5 ad,laSy

il oS (oo bl abaly cul ) g8 (>l 093 aBylaSy B J5US sl epsd alo e o
ve = 0.17\f. = 0.17 5 = 0.85 MPa
Sl e (s o
v, < 0v,,0 =0.75 - Qv, = 0.64 MPa
oS oo U )5, Bl 5 51 s o sl e¥lasl 5l d alols o 1, s S13 6523 (gla ailgs ol 3l e

Display>Show Slab Forces/Stresses...
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8] Siab Forces/Stresses 2 X
Load Case/Load Combination Component Type
() Load Case (O Resultant Forces () Stresses Top Face
® Load Combination |5hBalEnUEpr V| |Max V| (® Stresses Midsuface (O Stresses Bottom Face
Digplay Options Component
) Display Cortours on Undeformed Shape [@R:15] ® 513
(®) Display Cortours on Deformed Shape [@ N O 523
() Display Cortours in Extruded Form O 512 (O SMaxv
Sealing O smax
®) Automatic O shin
() User Defined Scale Factor O swm Show Amows

Cortour Averaging at Nodes
) Mone
(® by Objects
O by Selected Groups | Set Groups

Cortour Range

Minimum N/mmZ ‘ Ppply | | Close
— T

5 IS 45 o Sl P15 ] s w35 gl Sl g il pslie S G55 2 ol 3 oS (e 3

sk

i b 5 958 om ooliial g >les (sl oot almil golal Lo s8 S8 (gl daid Ceond (nl a8 el S3 4y p3Y
axgi b xS 90,5 pleol g L 1) g0 g Jgl al o ()55 (o0 090 (o0 plonil anlip Jasgd conlin (>)b loi Ll b az 5
Sl plril 1) poi (g J S s slog s polie 4

b sl s iy 5 F

JRlg aeSs 5l (P lals e 5 Sl (2L (50, l5 o -
Govb Wbl (b Jly 0 285 L 1o oz (i jemme S e S e b pln il wogd (oo 5L aS (5,5l 02y o
Ll b ng b cond (b slo)ls cnly ogdle il ools Bllad 098 (oo o lam &5 Slosr L aS 05 oo 5
LSS oy JoI ez 55 (b sla)le b oS (6975 a0 (o) 2 9590 S (loa b lime (LB 50) S0 o 5 ailSTa iy
dalst 5osle b ax 5 Sk lb)ly e &yganl 0 0,5 b Finite Elements ig, 40 1) po 15 as!
solazwl Replicate jsiws 4 (Draw >Draw Point) S bl oS 5 5l ol oo (b slo)lgs a5 (glpe (0

f‘)‘b <5L‘°)‘9-; P o)".\j‘ g = solawl =

o Slerian 25z 4 (b ey w5 (S gy (Il 0ed oo mum S iz la Y jo Liul) ya slalgs oS

10 g

oS blay SeS as Ll o b le dgl gy -

e5Y olaws s Relicate  jgiwo jloolatul b oo 5o ax 5 35 0 4y 35 0 alolb 4y >l)b)lei 1SS -

BB S0 Cl ) o Cond (nl slp e (ALl e 5 L gue 32 (g, 4 ng5 (A8 (S -
(595 ploxl 12
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Dbl ) 00,5 Sl 1) el sy 2 (b sla)lgi w5l g Pl sl 4 Ly o SloB oy -
< bl o &Y Gl 5 Select>Select>Properties>Select Design Strip Layers... s ;| 1L slalg

a5 (D
Design>Slab Design Overwrites>Strip Based...

el 00 Sl s 4 os Koo Slaseiie 45 05 oo o> liabl

] Strip Based Slab Design Overwrites 7 X

General

Design Thiz Strip
[ Ignere PT When Designing This Strip

Material
Rebar Materil C5A G30.18G:400 ~|[2]
Cower

(® From Preferences

(O Speciied to Center of Stesl
Top Cover

Battomn Cover

Live Load Reduction

Reduced Live Load Factor

0K | | Cancel |

b sl )ty laglas OY S
Sy 3 00,5 Ol ) &S sldls oo [i] g, a0 Bl Olon Bl )
Design>Slab Design Overwrites>Finite Elements Based...

sl o Sl s 4 oo Koo Slaseie 45 05 oo Jol> liabl

8 Finite Element Based Slab Design Overwrites T s
Material
Rebar Material C5A-G30 186400 <[]
Cover

(® From Preferences

(O Specified to Center of Steel
Direction 1 - Top Cover

Direction 1 - Bottom Cover
Direction 2 - Top Cover

Direction 2 - Bottomn Cover

Live Load Reduction
Reduced Live Load Factor

Design Option
Design This Slab Object
[ Ignare PT When Desigring This Slab Object

| oK | | Cancel |
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Sgamme izl g, a4 b Slaglass OF IS
b 5 el anld plnil 0

S oS 5 oo [0 LSS s o ol j0 0,8 pladl ls ol g Lo 4 s Glg o0 358 slo a5l am Coles o

: yiand )‘ ‘) 4.0[.3).3 Ja.w}a AW ul.’?w‘ Lg)L‘)f)lg
Design>Design Combo...
bl oo (b g Jelox | o5l s oS g0 S

b i 5 S olsie &1, 42,5 458l 5, Shw Ll iy S 1 3,50 i (sl oo (oo gl alio e
390 dlg> Ol > g il o Koo les 1 o 4y, PBBlas o Shs 0iS o0

Table 8.6.1.1—A, i, for nenprestressed two-way

slabs
Reinforcement

hype i MFEa A, mm?
Deforraed bars =220 0.00204,
Deforraed bars M{
orwelded wita | =420 Crentar of: £, d
relnforcamert D004,

sl JBlos o Sl 4

0.6.1.2 A, min =hall be the greater of () and (b), except as
provided in 9.6.1.3. For a statically determinate beam with
a flange in tension, the value of b, shall be the lesser of &,

and 2b,_.
{a) _ﬂ.ZSJfE’"d
i
14
—bd
® 7.
:JBly JIs g, 6lp onlnlo
0.0018(400) mm?
Asminrop = ——5— (1000)(70) = 126 " - use $12@25 cm
iz sl sl
14 ( )
Agminpor = max] 25 (120)(270), 7222 (120)(270)| = 113 mm? - use 912

21y 698 Bl polae Jb (e oo VY +) el ol oolain] casVl jo S aiily oy Slas slasl oy iy
g Vb usii slas Sl 5 (OF JS) oS 0 0,15 Typical Uniform Reinforcing <. o >1,b zls axan
oS oo edilo g |y Liwly o 0l
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i 5iab Design 7 x
Choose Display Type Choose Strip Direction
Design Basis |Suip Baszed ~ | Layer A
Display Type | Enveloping Flexural Reinforcement ~| [ Layer B
[ Impose Minimum Reinforcing || Layer Other
Rebar Location Shown Display Options
Show Top Rebar [ Fill Diagram
Show Bottom Rebar B Show Values at Controling Stations on Diagram
Reinforcing Display Type Show Rebar Above Specified Value
(O Show Rebar Intensity (Area/Unit Width) (O None
(O Show Total Rebar Area for Strip (® Typical Uniform Reinforcing Specified Below
(®) Show Number of Bars of Size: (O Reinforcing Specified in Slab Rebar Objects
Bar Size Typical Uniform Reinforcing
Top 14 s (® Define by Bar Size and Bar Spacing
Bottom 14 ~ (O Define by Bar Area and Bar Spacing

Reinforcing Diagram Bar Size Spacing (mm}

[ Show Reirforcing Envelope Diagram Tap 2 i | 250
Bott
Scale Factor | 2 12 ] |80

Show Reinforcing Extent

| Ppply | | Close |

Sloglas plo g mly 9 Yo Joo los M ol 9,5 5,15 OF U
Display>Show Slab Design...

MLQA})A)AJJ@?)A C.:L..: w‘d.Sd.MSuSé el 00U ul.?b)‘ \'f ).J‘)J ‘5,..:5.1: 6L{b0)ﬂm oJ,o.S OHF JS“:)O

el aml ol g YU Plas éj.il.:.a oS 0 oolatuwl agaze 132l g, 5l gl 6>|5j &l

0.0018(400) mm?

plonil 00 S5 illas Slonkats 5o 550 2o sl Khos alimle (glys 955 oo o3l 353 aml ly o YU o a8

- use P12@25 cm

Dy (s
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84 Slab Design ? *
Choose Display Type Reirforcing Direction and Location
Design Basis |Fmile Element Based v| ® Dirsction 1 - Top Rebar
Display Type |Em..ea.,ping Flexural Reinforcement v| (O Direction 1 - Bottom Rebar

[] Impose Minimum Reirforcing () Direction 2 - Top Rebar

(O Direction 2 - Bottom Rebar
Contour Range

Minimum mm2/m Show Rebar Above Specied Value
- mom O Nne

(@ Typical Unform Reinforcing Specified Below

Contour Averaging at Nodes
() Reinforcing Specied in Slab Rebar Objects

O None
@ by Objects Typical Uniform Reinforcing
(O by Selected Groups (® Define by Bar Size and Bar Spacing
(O Define by Bar Area and Bar Spacing
Bar Size Spacing {mm}
Top 12 ~| 250
Botom  [42 ~| [2s0 \

Rebar Averaging At Peaks
[ Average At Peaks

| Max. Averaging Width (m)

| Apply | | Close

Sgazee il (g) 4y o5 Connd )3 5L 9 90 (Lol Slos Kls osaline DO S5

3,5 )18 sy 9550 80 & Ll ,» Reinforcing Direction and Location cud jlas ol S35 4y 65V
Sr3e 3 dpdy Dygo ool cE Lo Sl ol jlade aul ccils b Jlasl piie los Ko ool &y L5 Logas
Sles osliial (b slajlys Gles 5l cenl gy <8l o 1) (he) Gl 4 jlisjse slod Se Jlade Culls )5 oS
o5 Bl Conl 2o ba)lgs nl (550 el S D jganl )3 09l SLRUl el ba Iy o0 wiled az s b SO
(BF JSB)ogd Sl Gl 9 (S sla)lys (S

Column strip £o/2 YExter'[or equivalent frame
i

One-half =) l..—Edge
middle strip ™ Centerline
T T_“_'T 'i 3 acljaclent
Til e
e
SR O R O T
— -%-—H—J- : £
Slab-beam |=t 4.%
strip £,/2 ——
Centerline /d_,__.l..—* Interior equivalent frame
of panel & -
& | £

25 >l o Ko sl Sl 5 Ssiw sloyls BF S
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@l ala>dle sl e (o0 bl 93 |y b az 25 (3 o, SAFE ailiy lo az i oS o b gl alixdo -
) e I B az 5 (A p (b

Display>Show Slab Design...
s Choose Display Type s ,o Strip Based au ;5 a5 osS Jol> ylaebl oS (o 5L 1 Ul (>lb oy
!y b oS okl |, Shear Reinforcement a5 Display Type cod 5l .asb oo bl Design Basis

QY USs) 098 0ol ioles 3li 090 e )BSLO)T S LA 5,50 4

B8] slab Design ? Pes

Choose Display Type

Choose Strip Direction

Design Basis |Snip Based v| Layer A
Display Type | Shear Reinforcament -] O Layer 8
| Layer Cther
Rebar Location Shown Display Options
Show Top Rebar ] Fill Diagram

] Show Bottom Rebar Show Values at Cortrolling Stations on Diagram

Reinforcing Digplay Type Show Rebar Above Speciied Value

(®) Show Rebar Intensity (Area/Unit Length) %) Nona
) Show Total Rebar Area for Strip () Typical Unform Reirforcing Speciied Below

() Show Mumber of Bars of Size: () Reinforeing Specified in Slab Rebar Objects

Bar Size Typical Uniform Reinforcing
jiop 2 5) Define by Bar Size and Bar Spacing
Bottom 14 (7} Define by Bar Area and Bar Spacing
5 o
Reinforcing Diagram Bar Size B Spacing {mm})
-
[ Show Reirforcing Envelope Diagram el I = |
Seale Factor | Hotiom e
Show Reinforcing Extent
| Apply | | Close

6‘1’)'«’ C)'b @L».: odaliw QY J&u

Ladd Coond (pl aS 0ad G805 090 duslie b a5 Dgels 6l u=_3.1):.>\ Slojz 5o oads el o, SKhe b sl ol oyl
o e 03D L)"AL’ Le‘.;‘ wl?bal)..\.woé‘d A_Jl?LA.»O 5; &Lb.o).vy 6& Cound L‘;"J)J C}uosl.s.osu))b Q).’)lsd?).».: ‘5‘)4
sy on s Sl (Vg 2 050V, ol 50 03 K s a5 3] 50l (s s ¥l g

g oolainl b az 5 plod ;o w3 alal) Billae obp Sgels J8las o)lgen

Table 9.6.3.3—Required A,

Beam type Ay il
’ bw
MNonprestressed O_OGQ,JZ— (a)
and prestressed ) ®
with 4,.£, < Greater of: N
0.4 dyfyy + AF) o_ssf—“’ o)
M
T

134
obe sagellae



oo (rwiige sl By Gldls (b sleial,

it $103,Sn Coral @y 55 b (S bI) SVT omo yo lo3, s il 5 S T35 il ool -
a I a5 G0l 50 LS |y s 4l (slos Shoo Sublo ) b iy sl oS 3l gy o JUi 4>
g,y bt lds Jolie ais (o) a4 mM1L, M22) bes ool 5l s 0 oo LS5 GiaS b 0 ) D) ozl o

5590 Jlasl Al jo 8 a5 ot ol 5l edel s 0 Kle o jlin 090 (o0 (5,l0093 Ll yo o1 1SS 5l g ol LB
DS oo ,l,8 oolal

(@h o) sz op iS5 7

pronl pogdle ail o Jolaal S 0929 Jdo 4 sl ailas ;o logas e slo J S 5l (o S @b o J S
a5 &dlse )0 @l Ghp IS sk 40yl mae sl Cadge pan 50 il J5SS 6l ale cudgae SAFE I3

D9 (g 2
(25 19 Gorm 02 9 285 (195 50 08) Do 4 25 b Jlasl -
Sl sl adsS (g o lgs 4 Jlo Jlail -

(Al g 4 G035 Llao slal) (gl ass slaylgo o jles 4y Jlo Jlasl -

W2l 08 I 4 g (PP By 2 g Sl -

a5 518 4 8 90 oyl ;0 SAFE asly slo Coogums 1 golass 3,k

2 sa)lpd Joe y3 @l (b damlns pas -

b ol Billas g5 i 5l )l (Pl 50 gl G dmlne GGl pue -

wiej onl 50 (I8 BB Slewlre dalgzn &5 550 )0 glib 5 9)l0 925 (398 OMShwe (6l (soriitns Jo o) ailinslie

Sygl g9y s sl J a8 4 b ans plxl
2,5 weolym j90 8y50 cnl 1315 55950 Sl a5 pdam SAFE asliyy )0 @by S W, SLIST L slesl sl

s Kha >1b oty Ceand )5 0nd angd b les 5l @l S8 sl - lankiti sl s ETABS 25,5 a.g5-

2S¢ o 0,33 SAFE_Final_Punch.FDB lsic cov jsSde Ll o)l T L Salés g 0gd (oo oolaul Jlo iwes

o 09d oo (b g Jelo BB (e (g9, 3V Sleckais plomil 5l @l (0 4] Al 5 (Aol 5 ol Lt

= ]
5 @l i dslome a4y pol8 asli s 0l a5 jslailen oS oo KIS |, S ST il i s alisdle gl ]
e 5 b sl e 0 rizmen (I (5t (53, N/C pliy (aled) al (o 5 0525 oo 2 Lo (y5
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opl ,e sl e (Edit>Edit Lines> Convert Beams to Slab Areas 4l .5 Clil) o @ o5 fas 50
Olebl Sz 5o (g crl Gl 5 08l (o0 0d hasd 15 Cualid pl s Culs S 0iS (o0 (28 aslip b

Sgalgm OA S Gillas b il o o) yoanno INONE & ahain jois 5 Jsl L, 5l ooliinl & jg0 j0 il oo

Assign > Beam Data>Beam Properties>None
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L P e | e e ) e e e |
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1 T P || |I I Il

(TGOS | | 'S5 1l l_ —

I
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I
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i lme o gt e daliy 05l se odmlive @l (b (255 swsp 9 B e S e (55, el SGISTL
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136
wlee sagallae



oo (rwiige sl By Gldls (b sleial,

Inaffactive

sl A
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Hote: Openings shown are located within
4h of the column periphary.

Fig. R22.6.4 3—Effect of openings and fFee edges (gffective

perimetar shown with dashed Iinas).

e 5o 5035 |y T 8 iy SaBn 5 s 03,5 DU (51 (K2 Ty B opgi db (5t gse 3ol sy
Design > Punching Shear Overwrite...

oogle lagSs b asl p sleols )| 3) vuiS o el o (5w cuxdse LOCation Type (See Tooltip) e

TS oo >yl g Sl 1 o5l Toazme o)lge () e 51

5 s 1 1 Gt plos I a0 8 Slaine |y gl (o 3,8hs (b 3T g o Slizal IS
Design>Punching Shear Overwrite...

Gl Caond 5l 0iS o Sl iy Ggels 1L sl Rebar Ties 4, ;5 Reinforcement Allowed cud
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ﬂ Punching Shear Design Overwrites ? *

Punching Shear Design Ovenwrite Options

Check Punching Shear | Program Determinad
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Location Type (See Tooltip) | Edge 2 w |
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Effective Depth |Aum w |
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Openings |ﬁum w | :. Speci
Reinforcement Allowed | Rebar Ties v |
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Reinforcement Spacing 100 mm
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Define Mass Source Using Load Pattems

Load Pattem Scale Factor
Dead ~ | 1.0000
SDead ~ | 1.0000
LiveF ~ |02

.+ | LiveS ~ |02
LiveP ~ 1

& o

lgnore Lateral Mass
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18.12.9.1 ¥V, of diaphragms shall not exceed:

V,= A, 01TMJF+p.f.) (18.12.9.1)
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12.5.3.4 For a diaphragm that is enfirely cast-in-place,

cross-sectional dimensions shall be selected to satisfy Eq.
(12.5.3.4).

¥, <0.6604,, /1 (12.5.3.4)

where the value of .ff used to calculate ¥; shall not
exceed 8.3 MPa.

25 e 4 oS80 amiio (55,0 o S5 (slp e ool 0 Togh oo B )5 L 10 - VOl @ 55 Ll o
oS oo ol
Hlre Vi dwlre -

v, = @ X min (0.17\/25 +0.0018(400), 0.66 ’f’c> = 1.18 MPa
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22.9.4.2 If shear-friction reinforcement is perpendicular to
the shear plane, nominal shear strength across the assumed
shear plane shall be calculated by:

V= 1Ay, (22.9.4.2)

where A, is the area of reinforcement crossing the assumed
shear plane to resist shear, and p is the coefficient of friction
in accordance with Table 22.9.4.2.

Table 22.9.4.2—Coefficients of friction

Coefficient of
Contact surface condition friction p

Concrete placed monolithically 140 (a)

Concrete placed against hardened concrete
that is clean, free of laitance, and intentionally
roughened to a full amplitude of approximately
6 mm

1.00 ()

Concrete placed agamst hardened conerete that
1s clean, free of laitance, and not mtentionally 0.6L (c)
roughened

Concrete placed against as-rolled structural
steel that 15 clean, free of paint, and with shear
transferred across the contact surface by headed
studs or by welded deformed bars or wires.

0.7h @

(U = 1.0 for normalweight concrete. For lightweight concrete, ). is calculated as given
in 19.2 4, but shall not exceed 0.85.
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40000 = 0.75 * 1.4 * 400 * A,y — A,y = 0.95 cm?/m
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18.12.3.2 Elements of a structural diaphragm system that
are subjected primarily to axial forces and used to transfer
diaphragm shear or flexural forces around openings or other
discontinuities shall satisfy the requirements for collectors
in 18.12.7.6 and 18.12.7.7.
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Table 18.12.7.6—Transverse reinforcement for
collector elements

Transverse
reinforcement Applicable expressions
A,,/sb, for rectilinear 0.09 € @
hoop . T 2
A r
045 [—g— 1]£ )
. Aa ) fn
p; for spiral or Greater
circular hoop of: ,
0. IZL (©
n

plol o9 (5,108 Cgals LS g0 10 b 0gd o awslie 0.2f7 L Envelope L oS5 sl S11,522 o adlge
D9 ol (6 )NS Dgels iz 4 5L el (S0 10 3 )lse gl o)l o el e 09
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Wall
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Table 18.12.7.6—Transverse reinforcement for
collector elements

Transverse
reinforcement Applicable expressions
A,,/sb, for rectilinear 0.09 £ @)
hoop . T 2
r
045 [—g— 1]£ )
. Aa ) fn
p; for spiral or Greater
circular hoop of: ,
O_IZL (©
n

N
- )
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